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CATIA V5 Mechanical Design Expert



Lesson 1: Introduction Introduction Student book reference: Student Guide: page title



Talk to the students: You should view the student manual as a supplement to, not a replacement for, the system documentation and on-line help. Once you have developed a good foundation in basic skills, you can refer to the on-line help for information on less frequently used command options. There are several other courses you can take to further develop and enhance your CATIA knowledge and skills. Please visit http://plm.3ds.com/education for a complete listing.



Class Agenda Talk to the students: Introduce the agenda for the week.



Objectives of the Day Talk to the students: Explain briefly the day’s objective and how this enables you to fulfill a part of the overall objective. Explain that each day has an objective, presented like this.



Review the User Interface Student book reference: Student Guide: Review the User Interface



Talk to the students: Introduce the step.
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CATIA V5 Mechanical Design Expert



CATIA Workbenches Student book reference: Student Guide: CATIA Workbenches



Talk to the students:



CATIA is mechanical design software. It is a feature-based, parametric solid modeling design tool that takes advantage of the easy-to-learn Windows graphical user interface. You can create fully associative 3-D solid models with or without constraints while utilizing automatic or user-defined relations to capture design intent. In the fundamentals course you were introduced to the Part design, Sketcher, Assembly Design and Drafting workbenches. In this course you will expand your knowledge of the Part design, and Assembly workbenches as well as learn some of the functionality available to you in the Generative Shape Design workbench.



Part Design Workbench Student book reference: Student Guide: Part Design Workbench



Talk to the students:



The part design workbench lets you build solid 3D geometry. It is one of the primary CATIA workbenches. From the Part Design workbench you can access the Sketcher workbench and create the 2D profiles that will become 3D model. In the Fundamentals course, you learned many of the sketched and dress up features available to you. In this course you will learn additional tools available from this workbench. As well, you will learn modeling techniques, such as the multi-body method. You will also learn how to access this workbench from the Assembly design workbench where you can begin to use collaborative methods such as Designing in Context, and the Skeleton method.
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CATIA V5 Mechanical Design Expert



Assembly Design Workbench Student book reference: Student Guide: Assembly Design Workbench



Talk to the students:



The Assembly Design workbench lets you bring components together to create the final product. In the Fundamentals course, you learned how to rigidly constrain components to build assemblies. In this course you will learn how to build flexible assemblies, and how to analyze assemblies. You will also learn how to access the part design workbench from inside the assembly. This lets you build parts in the context of the assembly. Contextual design is a powerful tool that gives you the opportunity to create parts in an associative manner. You will also learn methods of designing assemblies that will aid in concurrent engineering, such as Skeleton models and publishing elements.



Generative Shape Design Workbench Student book reference: Student Guide: Generative Shape Design Workbench



Talk to the students: Review overall use of GSD without going into details.



Importance of Parent/Child Relationships Student book reference: Student Guide: Importance of Parent/Child Relationships



Talk to the students:



Introduce the step.



Parent/Child Relationships (1/3)
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CATIA V5 Mechanical Design Expert Student book reference: Student Guide: Design Intent, Parent/Child Relationships (1/6)



Talk to the students:



Changing the design intent in a solid model can be very time consuming and costly, therefore adequate planning and time should be given to understanding the design intent before begin to create the feature elements to represent the part. The way that the design intent is captured will influence the relationships and dependencies in the final model. Automatic (Implicit) Relations: Based on how geometry is sketched, automatic relations provide common geometric relationships between objects, such as tangency, parallel, perpendicular, horizontal, and vertical. Equations: Equations relate dimensions mathematically; they provide an external way to force changes. Additional Relations: Other relations added to the model as it is created provide another way to connect related geometry. Some common relations are concentric, coincident, and offset. Dimensioning: The way in which a sketch is dimensioned impacts design intent. Add dimensions in a way that reflects how you would like to change them and control the elements. Displayed example: maybe circle concentricity, hole center dimensions equal etc. An important aspect to maintain design intent is the parent/child relationships built into your model. The dependency between one feature to another is known as a parent child relationship. Changes to the parent feature can affect the child features, so it is important to create the proper relationships when modeling. Displayed example: how hole centers are dimensioned with respect to a reference plane and side face.



Ask the students:



Can you think of other ways to create parent/child relationships?
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CATIA V5 Mechanical Design Expert



Parent/Child Relationships (1/3) Student book reference: Student Guide: Design Intent, Parent/Child Relationships (1/6)



Talk to the students:



Changing the design intent in a solid model can be very time consuming and costly, therefore adequate planning and time should be given to understanding the design intent before begin to create the feature elements to represent the part. The way that the design intent is captured will influence the relationships and dependencies in the final model. Automatic (Implicit) Relations: Based on how geometry is sketched, automatic relations provide common geometric relationships between objects, such as tangency, parallel, perpendicular, horizontal, and vertical. Equations: Equations relate dimensions mathematically; they provide an external way to force changes. Additional Relations: Other relations added to the model as it is created provide another way to connect related geometry. Some common relations are concentric, coincident, and offset. Dimensioning: The way in which a sketch is dimensioned impacts design intent. Add dimensions in a way that reflects how you would like to change them and control the elements. Displayed example: maybe circle concentricity, hole center dimensions equal etc. An important aspect to maintain design intent is the parent/child relationships built into your model. The dependency between one feature to another is known as a parent child relationship. Changes to the parent feature can affect the child features, so it is important to create the proper relationships when modeling. Displayed example: how hole centers are dimensioned with respect to a reference plane and side face.



Ask the students:



Can you think of other ways to create parent/child relationships?



Parent/Child Relationships (2/3)
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CATIA V5 Mechanical Design Expert Student book reference: Student Guide: Parent/Child Relationships (2/6), (3/6), (4/6)



Talk to the students:



You should carefully consider choosing the best base feature, what parent/child relationships should exist, and what dimensions and feature order best reflect the intended design intent. Many design practices are derived from company standards and need to be considered before modeling is started. Some common design practices are: Always choose the most stable feature in the model as the base feature. Try to avoid creating references to dress-up features such as fillets and chamfers. These features many be removed in downstream applications. Choose the best depth option for the application. For example, decide if a pocket is required to always cut through the entire model. Creating the pocket with a dimensional depth is not recommended, because the depth of the feature it is cutting through may change; instead, create the pocket with an Up to Last depth. First case: Create a Base Pad from the sketch shown. Create another sketch on the top face of Base Pad. Constrain the sketch completely using the edges of the Pad. Using this sketch create a Upper Pad. Create a sketch on the top face of Upper Pad. Create a Pocket. Create the holes on the top face of the Upper pad. Dimension the holes with respect to the Pad edges. Creation of chained dependencies: The upper pad is dependent on the Base Pad, the Pocket is dependent on the Upper Pad, and when we try to delete the Upper Pad, an update error is displayed. On deletion of Parent feature, the child features are affected.
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CATIA V5 Mechanical Design Expert



Parent/Child Relationships (2/3) Student book reference: Student Guide: Parent/Child Relationships (2/6), (3/6), (4/6)



Talk to the students:



You should carefully consider choosing the best base feature, what parent/child relationships should exist, and what dimensions and feature order best reflect the intended design intent. Many design practices are derived from company standards and need to be considered before modeling is started. Some common design practices are: Always choose the most stable feature in the model as the base feature. Try to avoid creating references to dress-up features such as fillets and chamfers. These features many be removed in downstream applications. Choose the best depth option for the application. For example, decide if a pocket is required to always cut through the entire model. Creating the pocket with a dimensional depth is not recommended, because the depth of the feature it is cutting through may change; instead, create the pocket with an Up to Last depth. First case: Create a Base Pad from the sketch shown. Create another sketch on the top face of Base Pad. Constrain the sketch completely using the edges of the Pad. Using this sketch create a Upper Pad. Create a sketch on the top face of Upper Pad. Create a Pocket. Create the holes on the top face of the Upper pad. Dimension the holes with respect to the Pad edges. Creation of chained dependencies: The upper pad is dependent on the Base Pad, the Pocket is dependent on the Upper Pad, and when we try to delete the Upper Pad, an update error is displayed. On deletion of Parent feature, the child features are affected.



Parent/Child Relationships (3/3) Student book reference: Student Guide: Parent/Child Relationships (5/6), (6/6)



Talk to the students: Create a Base Pad from the sketch shown. Create a ‘Sketch’ for ‘Upper Pad’ on the Top reference plane. Dimension the Sketch with reference to standard Planes. Create a ‘Sketch’ for ‘Pocket’ on the top reference plane. Dimension the Sketch with reference to standard Planes. Create ‘Pocket’ using this ‘Sketch’. Create the holes on the top face of the ‘Upper Pad’. Dimension the holes with respect to the standard Planes.
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CATIA V5 Mechanical Design Expert



Investigating the Model Student book reference: Student Guide: Investigating the Model (1/2), (2/2)



Talk to the students:



CATIA has tools available to help you investigate a model. These tools can be used to help determine how a model was made, and what parent/child relationships exist. For solid modeling, bodies are ordered geometry containers. Features are added to the tree in the order of creation. Therefore children cannot exist in the tree before their parents. To use the Model scan, click Edit > Scan or Define in Work Object. Using this feature helps avoid creating parent child relationships with the wrong features. By adding the feature just below the Pad feature you are ensuring that the only relationships that are created are with the Pad feature and the reference planes. To use the Parent/Child tool, right click on the feature and click Parent/Children from the contextual menu.



What is Define in Work Object? Student book reference: Student Guide: What is Define in Work Object?



Talk to the students: Used to create a feature at the right place and in the right order.



Defining in Work Objects Student book reference: Student Guide: Defining in Work Objects (1/2), (2/2)



Talk to the students: Using this feature helps avoid creating parent child relationships with the wrong features. By adding the feature just below the Pad feature you are ensuring that the only relationships that are created are with the Pad feature and the reference planes. Describe the steps. Step 3. Notice that they are placed directly below the active feature in the specification tree. To re-activate all features in the model, right mouse click on the last feature in the Body and click Define In Work Object from the contextual menu.
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CATIA V5 Mechanical Design Expert



Organizing a Solid Model Student book reference: Student Guide: Organizing a Solid Model



Talk to the students:



Introduce the step.



Model Organization Student book reference: Student Guide: Model Organization, Bodies



Talk to the students: As you begin to create increasingly complex models, your ability to structure your model properly becomes more important. A properly organized model has the following advantages: - The model will be easier to interpret by other designers - The model will behave more predictably during modification and update - It will be easier to reorder and replace features - Problem solving becomes easier as the root cause of the problem can be easily identified. Additional bodies can be added in order to provide structure to a complex model. To add a body, click Insert > Body. Describe the multi-body model organization (use of naming).



Geometrical Sets Student book reference: Student Guide: Geometrical Sets



Talk to the students: Geometrical Sets are a storage location for wireframe and surface features. The features in a geometrical set behave in a non-linear fashion. It is possible to reference a feature that resides in a later position in the tree. Multiple Geometrical Sets can be added to a model in order to organize the wireframe and surface geometry. Wireframe and construction geometry could be separated from surface geometry that will be used to create a solid. Geometrical Sets can also be placed within a body. This allows you to group the wireframe and surface geometry and solid geometry within the same body. The body now represents all geometry for a given area of the model providing the designer faster access to the required features.
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CATIA V5 Mechanical Design Expert



Ordered Geometrical Sets Student book reference: Student Guide: Ordered Geometrical Sets



Talk to the students:



An ordered geometrical set is a geometrical set with “history” and behaves similar to a Part body. This allows the ordered geometrical set to have the following additional functionalities: Features can be scanned (using Edit > Scan or Define In Work Object) allowing you to see the way the features were created Geometry that is consumed by a downstream feature (e.g. a surface that is trimmed) are not shown. You can reorder the elements. Graphical properties for new elements are inherited from parent elements. You can manually add an ordered geometrical set to the model by clicking Insert > Ordered Geometrical Set.



Hybrid Design Student book reference: Student Guide: Hybrid Design (1/2), (2/2)



Talk to the students: A Hybrid body can contain both solid geometry and wireframe and surface geometry without needing to add a geometrical set. The ability to combine wireframe and surface features with solid feature within the same body allows you to organize the features of the model with respect to their function. For example, the righthand side image depicts a part model that has been created using hybrid bodies. All the geometrical elements of a specific area of the model have been grouped beneath a hybrid body.



Part Design Recommendations (1/2) Student book reference: Student Guide: Part Design Recommendations (1/2)



Talk to the students:



It is strongly recommended to organize the structure of your CATIA V5 tree in the same way as the set of functional requirements.
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CATIA V5 Mechanical Design Expert



Part Design Recommendations (2/2) Student book reference: Student Guide: Part Design Recommendations (2/2)



Talk to the students:



Describe process in general terms. Will be explained in detail in a later lesson.



Exercise Overview Student book reference: Student Guide: Case Study: Introduction



Show the students:



Demonstrate the topics reviewed in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class.



Talk to the students:



Present the exercises available to practice creating drawings. As a class discuss what will be involved in completing the exercises. What tools will they need to use? Tell students where they will be saving the models to and where the required start parts are located. State that they are to move from one exercise to the next and complete all three exercises and the case study (time permitting).



Case Study: Introduction Student book reference: Student Guide: Case Study: Hinge



Talk to the students: Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Have the students begin the exercises and note the time. Assist students as needed with the exercise.



Case Study: Hinge Recap Student book reference: Student Guide: Case Study: Hinge Recap



Talk to the students: Discuss the objectives of the case study. Review the process used to create the part. Ensure the students understand the process used to create the case study before moving on.
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Course Title Your Notes:
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CATIA V5 Mechanical Design Expert Your Notes:



Lesson 2: Design Complex Parts Design Complex Parts Student book reference: Student Guide: Design Complex Parts



Talk to the students: Introduce the lesson.



Case Study Student book reference: Student Guide: Case Study: Design Complex Parts, Design Intent, Stages in the Prcess



Talk to the students: Introduce the case study. Design Intent and Stages in the Process



Create Advanced Sketch-Based Features Student book reference: Student Guide: Create Advanced Sketch-Based Features



Talk to the students:



Introduce the step.



Use of Ribs and Slots Student book reference: Student Guide: What are Ribs and Slots?, When Should Ribs and Slots Be Used?



Talk to the students:



To create a rib or slot, you must have the following: The profile which can be a planar open or closed loop sketch. The center curve which can be a planar sketch or a non-planar continuous wire-frame element. Ribs and slots are used to create complex walls with many details. Using a rib or slot feature enables you to control the complexity of the sketch and create, in one feature, what may take many using other features (such as pads and pockets). Ribs can be used to create a pipe feature by sweeping two closed loop profiles, created in the same sketch, along a center curve.
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CATIA V5 Mechanical Design Expert Your Notes: Creating a Rib Student book reference: Student Guide: Creating a Rib



Talk to the students:



Step 3: In this example, the center curve is a 3D curve created in the Wireframe and Surface Design workbench. Step 4: Control option. In this example, Pulling direction is selected and the top surface of the base feature is selected as the reference.



Creating a Slot Student book reference: Student Guide: Creating a Slot



Talk to the students:



Step 2: The depth of the profile must be equal to or less than the radius of the center curve Step 4: Control option. In this example, the default option, Keep Angle is selected.



Creating Thin Ribs and Slots Student book reference: Student Guide: Creating Thin Ribs and Slots (1/3), (2/3), (3/3)



Talk to the students: Type speech



Rib and Slot Options Student book reference: Student Guide: Rib and Slot Options (1/2), (2/2)



Talk to the students: The Keep Angle option maintains a constant angle between the profiles sketch support and the tangent of the center curve The Pulling Direction option causes the profile to be swept along the center curve with respect to a specified direction. The direction can be defined using a plane or an edge. The Reference Surface option causes the profile to remain at a constant angle to a selected reference surface. Merge ends option cleared: In the example shown, the feature does not fully extend to the edge of the base feature when the option is cleared. Merge ends option selected: In the example shown, the profile is extended to fully intersect the base feature.
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CATIA V5 Mechanical Design Expert Your Notes: Solid Combines Student book reference: Student Guide: Solid Combines (1/2), (2/2)



Talk to the students:



Step 1: The sketched must contain closed profiles. Step 5: By default, profiles are extruded normal to the sketch support. To change the direction, clear the Normal to Profile option and select a geometrical element to indicate the extrude direction. Step 6: The solid combine is the intersection of these profiles when they are extruded.



Multi-Sections Solids Student book reference: Student Guide: Multi Sections Solids



Talk to the students: Introduce the step.



Multi-Sections Solid Student book reference: Student Guide: Multi-Sections Solid



Talk to the students: Sometimes called lofts. Common uses for multi-sections solids are to create complex solids and transition geometry between two existing solids.



Closing Point and Orientation (1/2) Student book reference: Student Guide: Multi-Sections Solids: Closing Point and Orientation (1/4), (2/4)



Talk to the students:



Closing points and directional arrows also apply to removed multisections solids. The directional arrow indicates the direction of the next aligned vertices. Ensure the arrow points in the same direction for each section. Closing points must be aligned for proper orientation of the sections.
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CATIA V5 Mechanical Design Expert Your Notes: Closing Point and Orientation (2/2) Student book reference: Student Guide: Multi-Sections Solids: Closing Point and Orientation (3/4), (4/4)



Talk to the students: If there is no vertex in the required location for the closing point you can create a closing point while in the feature operation. Step 5: Define the point location using the Point Definition dialog box. Step 6: Select OK to generate the closing point and return to the feature definition.



Creating a Simple Multi-Sections Solid Student book reference: Student Guide: Creating a Simple Multi-Sections Solid



Talk to the students:



Describe the steps. Use the same process to create a removed multi-sections solid.



Guides Student book reference: Student Guide: Multi-Sections Solid Creation : guides



Talk to the students:



guides are used to help control the shape of the multi-section solid as it transitions between the profiles. guides MUST intersect all sections of the feature. This example uses the same profiles as in the previous example. Notice the difference in the transitional surfaces by using the guides.



Spine Student book reference: Student Guide: Multi-Sections Solid Creation : Spine



Talk to the students: A spine is used to control the shape of the feature between the profiles. As the feature transitions between the sections it must always remain perpendicular to the spine. A spine is automatically computed when creating the solid. If required, you can use a user-defined spine. Only one spine can be applied. It can be defined as a sketch, edge, or 3D curve. This example uses the same profiles as in the previous examples. Notice the difference in the transitional surfaces by using a user defined spine.
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CATIA V5 Mechanical Design Expert Your Notes: Tangent Surfaces Student book reference: Student Guide: Multi-Sections Solid Creation : Tangent Surfaces



Talk to the students:



When multi-sections solids are used as transitional features, it is often required that they be tangent to the adjoining solid. In the example both the first and last sections have applied tangency constraints. This is the most common case, but tangency can also be applied at intermediate sections.



Coupling Student book reference: Student Guide: Multi-Sections Solid Creation : Coupling, Coupling : Points of Continuity



Talk to the students: Coupling refers to the way the profiles are connected. Ratio: the curves are coupled according to a ratio of the total length of each section. Tangency: the curves are coupled at their tangency discontinuity points. To use this option the same number of tangency discontinuity points must exist in all sections. Tangency then curvature: the curves are coupled at their tangency discontinuity points first and then their curvature discontinuity points. To use this option the same number of tangency discontinuity point and curvature discontinuity points must exist in all sections. Vertices: the curves are coupled at their vertices. To use this option the same number of vertices must exist in all sections.



Modify Coupling Student book reference: Student Guide: Coupling



Talk to the students:



In this example, a multi-sections solid will be created. Step 4:the Ratio option is selected because the number of vertices in each section is not equal. However, this option can often give unpredictable results
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CATIA V5 Mechanical Design Expert Your Notes: Displaying Uncoupled Points Student book reference: Student Guide: Manual Coupling: Displaying Uncoupled Points (1/2), (2/2)



Talk to the students: An error will display if CATIA cannot couple the profiles automatically. For each coupling mode, the points that could not be coupled are displayed in the geometry with specific symbols. Using manual coupling, you can combine multiple vertices from one section into one vertex in another. Uncoupled tangency discontinuities are represented by a square. Uncoupled Curvature discontinues are represented by an empty circle. Uncoupled vertices are represented by a full circle.



Manual Coupling Student book reference: Student Guide: Multi-Sections Solid : Manual Coupling (1/2), (2/2)



Talk to the students: If the sections in the multi-sections solid (or removed multi-sections solid) do not have the same number of vertices you can define the coupling manually. Step 2: If the Add button is grayed out, select inside the coupling window to activate it. Step 4: Remember to select the points in the correct order or the feature will fail. Once the coupling points for each section have been defined, the Coupling dialog box automatically disappears. Repeat above steps for each coupling.
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CATIA V5 Mechanical Design Expert Your Notes: Relimitation Student book reference: Student Guide: Multi-Sections Solid Relimitation (1/3), (2/3), (3/3)



Talk to the students:



By default, Multi-sections Solids and removed Multi-sections Solids are limited by the start and end sections, whichever is the shortest. You can choose to change the limit of the feature to the length of a user-defined spine or guides. You can limit the start or the end section of the feature by clearing the appropriate option on the Relimitation tab. For example, when a multi-sections solid is created through three sections and the Relimited options are selected, the feature will be limited by the start and end sections. For example, a multi-sections solid is created through three sections with a spine that extends past the first and last sections. If the Relimited on start section and Relimited on end section options are cleared, the feature will extend past the start and end sections to the start and end points of the spine.



Exercise Overview Student book reference: Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see the demonstration first, while others will prefer to first try the exercises and then see the demonstration.



Talk to the students: Present the exercises available to practice the skills learned in this part of the lesson. As a class discuss what will be involved in completing the exercises. What tools and options will they need to use? Tell students where they will be saving the models to and where the required start parts are located. State that they are to move from one exercise to the next and complete all four exercises (time permitting).
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CATIA V5 Mechanical Design Expert Your Notes: Rib and Slot (Limited Instructions): Recap Student book reference: Student Guide: Rib and Slot (Limited Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Thin Rib (Detailed Instructions): Recap Student book reference: Student Guide: Multi-Sections Feature (Detailed Instructions): Recap



Talk to the students:



Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Multi-Sections Feature (Detailed Instructions): Recap Student book reference: Student Guide: Multi-Sections Feature (Detailed Instructions): Recap



Talk to the students: Discuss the different options used in this exercise.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?



Rib and Multi-Section Solid (Limited Instructions): Recap Student book reference: Student Guide: Rib and Multi-Section Solid (Limited Instructions): Recap



Talk to the students:



Discuss the different tools and options used in this exercise.



Ask the students: Ask if there are any questions or difficulties regarding this exercise? Ensure that there are no questions before moving on to the next step.
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CATIA V5 Mechanical Design Expert Your Notes: Create Advanced Drafts Student book reference: Student Guide: Create Advanced Drafts



Talk to the students:



Introduce the step.



Introduction Student book reference: Student Guide: Introduction (1/2), (2/2)



Talk to the students: By default, the Advanced Dress-Up Features toolbar is not displayed in the Part Design workbench. To display the toolbar, click Views > Toolbars > Advanced Dressup Features. Select the appropriate button (s) in the Advanced Draft definition panel to create the necessary draft.



Creating an Advanced Draft (1/2) Student book reference: Student Guide: Creating an Advanced Draft (1/5), (2/5)



Talk to the students:



The draft angle is the angle that the draft faces make with the pulling direction from the Neutral Element. This angle may be defined for each face. These are the surfaces where the draft will be applied. The drafted surfaces pivot about a neutral curve, the hinge, where it intersects the Neutral Element. The Neutral Element, usually a plane or face, can be the same reference used to define the pulling direction. The pulling direction defines the direction from which the draft angle is measured. It derives its name from the direction that the sides of a mold are pulled to extract a molding. With the Advanced Draft the sides of a face can be drafted with 2 different pulling directions.
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CATIA V5 Mechanical Design Expert Your Notes: Creating an Advanced Draft (2/2) Student book reference: Student Guide: Creating an Advanced Draft (3/5), (4/5), (5/5)



Talk to the students:



With the Independent option, draft is created where both the 1st side draft angle and the 2nd side draft angle must be defined. With the Driving\Driven option, the angle specified for the driving side controls the angle specified for the driven side. With the Fitted option, a draft is created on two opposite sides of the part and adjusts the resulting faces using the selected parting element. To define a second draft angle, select the appropriate second side option from the top of the dialog box and from the 2nd side tab, define the second draft. Most of the options necessary to define the 2nd side of the draft are the same as those that defined the 1st side of the draft. Exception = Faces to draft



Advanced Draft Angle: Draft Both Sides (1/3) Student book reference: Student Guide: Advanced Draft Angle: Draft Both Sides (1/5), (2/5)



Talk to the students: Describe the steps.



Advanced Draft Angle: Draft Both Sides (2/3) Student book reference: Student Guide: Advanced Draft Angle: Draft Both Sides (3/5), (4/5)



Talk to the students: Describe the steps.



Advanced Draft Angle: Draft Both Sides (3/3) Student book reference: Student Guide: Advanced Draft Angle: Draft Both Sides (5/5)



Talk to the students:



Describe the steps.
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CATIA V5 Mechanical Design Expert Your Notes: Advanced Dress-Up Features Student book reference: Student Guide: Create Advanced Sketch-Based Features



Talk to the students:



Introduce the step.



Introduction Student book reference: Student Guide: Introduction



Talk to the students: Review features without going into details.



What is Thickness? Student book reference: Student Guide: What is a Thickness? (1/2, (2/2)



Talk to the students: It can also be used to apply thickness to selected walls of a shelled model. You may want to say that a Thickness feature is preferred to the use of “Other faces” options in the Shell function because a specific editable feature is created.



Creating Thickness (1/2) Student book reference: Student Guide: Creating a Thickness (1/2)



Talk to the students:



Describe the steps.



Creating Thickness (2/2) Student book reference: Student Guide: Creating a Thickness (1/2)



Talk to the students: Optional steps only completed if some faces require a different thickness value. Describe the steps. May not be recommended for some companies who will recommend 1 thickness value per feature. The same remark applies to the use of the Shell function.
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CATIA V5 Mechanical Design Expert Your Notes: Ignoring Faces Student book reference: Student Guide: Ignoring Faces When Creating a Thickness, Reset Ignored Faces Option for Thickness Tool



Talk to the students: In some cases, when you apply a thickness, an error message appears indicating that some of the body cannot be built properly. After closing the window, another message appears prompting you to ignore the problem faces. If you select Yes, the thickness is created and the face causing the issue is removed. Ignored faces are previewed when the thickness is edited. The option Reset ignored faces appears in the Thickness Definition Dialog box. After selecting this option, the ignored faces are reinitialized and the Ignored Face note is removed from the geometry. This may be done after having modified upstream geometry to remove the source of the original error.



Remove Faces Student book reference: Student Guide: Remove Faces (1/2), (2/2)



Talk to the students: For example, to simplify the part for a finite element analysis. Describe the steps. Step 5: Used to preview the result as faces are selected to be kept or removed.



Replace Face Student book reference: Student Guide: Replace Face



Talk to the students:



Adds a variable thickness. Adds another feature to the model tree. It does not alter the original extrude feature.



Exercise: Geometry Replace



Exercise: Solid Combine and Advanced Draft
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CATIA V5 Mechanical Design Expert Your Notes: Do it Yourself (4/9)



Exercise: Advanced Draft



Do it Yourself (3/6)



Use the Multi-Body Method Student book reference: Student Guide: Use the Multi-Body Method



Talk to the students: Introduce the step.



What is Multi-Body Method? Student book reference: Student Guide: What Is the Multi-Body Method?



Talk to the students:



Each geometry area is created in a separate body. The Pillar model is divided into four bodies. The bodies are then combined using Boolean Operations to create the completed model shown in the top, right-hand image.
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CATIA V5 Mechanical Design Expert Your Notes: Using the Multi-Body Method Student book reference: Student Guide: Using the Multi-Body Method (1/2), (2/2)



Talk to the students:



1. Break the model into bodies: Consider the areas of the model that should be contained in a separate body. These can be functional areas, for example a complex cutout or area of the model Try to combine features that can similar design intent into the same body. Create as many bodies as required. 2. Define the body structure: Click Insert > Body to add a new body to the model Bodies should be descriptively named so that the design intent is clear. 3. Insert features into the bodies: To activate a body, select it from the specification tree and click Define In Work Object from the right mouse button contextual menu. Advantages: Solid features within a body can be hidden independently of the rest of the model. Groups of geometry can be de-activated by de-activating the body. Complex geometry is easier to create within a focused area of the model. Model will typically update faster due to the organized structure. Disadvantages: The number of operations that have to be performed by the user will be greater than for pure feature modeling in a single body.



What Are the Boolean Operations? Student book reference: Student Guide: What Are the Boolean Operations?



Talk to the students:



Boolean operations enable you to use a multi-body approach to modeling. Using multiple bodies in a model or in different models, you can use Boolean operations to manipulate the bodies to achieve different results. For example, casting models can be developed using bodies to represent cast and machined features. Assemble: Uses the notion of positive or negative material to automatically perform an Add (if the selected body is positive), or a remove (if the selected body is negative). A body is positive if the first feature within it adds material (ex. Pad, Rib), and negative if the first feature removes material (ex. Hole, Pocket). Do not describe the functions in detail.
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CATIA V5 Mechanical Design Expert Your Notes: Boolean Operation: Assemble Student book reference: Student Guide: Assemble (1/4), (2/4), (3/4), (4/4)



Talk to the students:



In this example, Body.2 will be assembled into PartBody. When Body2 is assembled to PartBody, the operation between the bodies is a union. An Assemble operation will respect the “nature” of features. If Body2 contains a Pocket as its first feature, the Assemble operation will remove material from Body1. By default, the selected body will be assembled to the active body as the last feature. If required, select another body to which the selected body will be assembled. Step3: If there are only two bodies the Boolean operation will be performed automatically. Click OK to finalize the operation. Notice that Body.2 contains a groove. Because groove features remove material, the result of the union removes material.



Boolean Operation: Add Student book reference: Student Guide: Boolean Operation: Add (1/2), (2/2)



Talk to the students:



In this example, Body.2 will be added to the PartBody. The Add operation creates a union between the selected bodies. If Body2 contains a pocket as its first feature, using an Add operation the pocket will be treated as a pad. Step3: The Add dialog box only displays if there are more than two bodies in the model. If only two bodies exist, the operation is automatically applied to the second body without user input.



Boolean Operation: Remove Student book reference: Student Guide: Boolean Operation: Remove (1/2), (2/2)



Talk to the students: In this example, Body,2 will be removed from the PartBody. If Body2 is Removed from PartBody, the operation is PartBody minus Body2. Step3: The Removed dialog box only displays if there are more than two bodies in the model. If only two bodies exist, the operation is automatically applied to the second body without user input.
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CATIA V5 Mechanical Design Expert Your Notes: Boolean Operation: Intersect Student book reference: Student Guide: Intersect (1/2), (2/2)



Talk to the students:



In this example, Body.2 will intersect PartBody. The resulting solid is the material common between the two intersecting bodies. Step3: The Intersect dialog box only displays if there are more than two bodies in the model. If only two bodies exist, the operation is automatically applied to the second body without user input.



Boolean Operation: Union Trim Student book reference: Student Guide: Union Trim (1/2), (2/2)



Talk to the students:



In this example, Body.2 will be used to trim the PartBody. The Union Trim is a union with an option to remove or keep one side. One face can be selected to remove the lower section of Body.2 while keeping the outer section of PartBody, and one face is selected to keep only the top of Body.2. For the Union Trim to work, the geometry must have sides that are clearly defined. Steps 6/7: It is not always necessary to select faces to keep.



Boolean Operation: Removing Lump Student book reference: Student Guide: Boolean Operation: Removing Lump (1/3), (2/3)



Talk to the students:



Lump and cavities may appear in the model after certain operations. These elements can be removed using the Remove Lump tool. The previous options work between two bodies. The remove lump option works on geometry within a specific body. A lump is the material that is completely disconnected from other parts within a single body. You can delete any lump as a single entity even if the lump is a combination of features.
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CATIA V5 Mechanical Design Expert Your Notes: Replacing a Body (1/2) Student book reference: Student Guide: Replacing a Body (1/3), (2/3)



Talk to the students:



Using the Replace tool you can replace a body used in an operation by another one. This eliminates the need to delete the operation and redo it with the correct body. Step 4: In this example, additional references are required to replace the bodies. From the Replace dialog box click on the second field. Step 5: A Replace Viewer dialog box displays the reference. Select the appropriate reference in the replacing body. In this example, the missing reference is the face that is to be removed during the Union Trim operation.



Replacing a Body (2/2) Student book reference: Student Guide: Replacing a Body (2/3, (3/3)



Talk to the students: Describe the steps. Body.3 will appear as a separate node in the specification tree and will be displayed as an independent body.



Changing the Boolean Operation Type Student book reference: Student Guide: Changing the Boolean Operation Type (1/2), (2/2)



Talk to the students:



The type of Boolean operation can be changed without having to delete the operation and recreate it. Three bodies are constructed. Body.2 (B) and Body.3 (C) have both been assembled into the PartBody (A). However, Body.3 should have been Removed from the PartBody. Step1: In this example, the Assemble operation is to be replaced. Step 3: Here, the Change to Remove option is selected.
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CATIA V5 Mechanical Design Expert Your Notes: Maintain a Flat Specification Tree Structure Student book reference: Student Guide: Recommendations for Working with Boolean, Maintain a Flat Specification Tree Structure (1/2), (2/2)



Talk to the students: Dress-up features as close possible as to the solid primitive. The dress-up features do not need to be added as the design progresses: they can be added at the end of the design process. The use of Define in Work Object function will allow you to create the features at the correct position in the specification tree.



Create Multi-Model Links Student book reference: Student Guide: Create Multi-Model Links



Talk to the students:



Introduce the step.



What Are Multi-Model Links? Student book reference: Student Guide: What Are Multi-Model Links? (1/3), (2/3), (3/3)



Talk to the students: Geometry can be shared between models to quickly replicate features in a number of parts. However, in order to share geometry, it is recommended that the elements first be published. In this case the shared geometry can be restricted to published elements only (this subject will be treated in full later). In the context of the concurrent engineering, Multi-Model Links enable you to design a model using elements from another model. Using Multi-Model links you can copy bodies created in different files into your own part. Doing so enables an automatic update of your part when changes occur in the source files. Describe the steps. Example shows use of a published element (P).



Establishing Multi-Model Links (1/3) Student book reference: Student Guide: Establishing Multi-Model Links (1/3)



Talk to the students:



Describe the steps.
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CATIA V5 Mechanical Design Expert Your Notes: Establishing Multi-Model Links (2/3) Student book reference: Student Guide: Establishing Multi-Model Links (2/3)



Talk to the students:



Describe the steps.



Establishing Multi-Model Links (3/3) Student book reference: Student Guide: Establishing Multi-Model Links (3/3)



Talk to the students: Describe the steps.



Paste Special Student book reference: Student Guide: Paste Special (1/3) (2/3) (3/3)



Talk to the students: The option you select depends on the design intent. The As Specified in Part Document option copies the element (s) with their design specifications. Each feature is recreated in the target model and can be edited. There is no link to the source model. The As Result option copies the element (s) without their design specifications and without a link. This option is useful when you do not want feature information to be shown or when you do not want to make changes to the copied elements in the target document. Notice that when the ‘Construction Element’ Geometrical Set from the target model is copied using this option, it creates datum surfaces in the copied Geometrical set denoting the surfaces with a red lightning bolt. This indicates that the link has been isolated. The As Result with Link option can be used for copying the individual features and not on the entire Geometrical set. It copies the element (s) without their design specifications and links the copied element (s) to the original object (s). When changes occur in the source document they will update in the target document. Can mention differences in display when published or un-published elements are copied.
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CATIA V5 Mechanical Design Expert Your Notes: Managing Multi-Model Links (1/3) Student book reference: Student Guide: Managing Multi-Model links (1/4)



Talk to the students:



When you sue the Paste Special option As result with Link you create a link between the source document and the target document.



Managing Multi-Model Links (2/3) Student book reference: Student Guide: Managing Multi-Model links (2/4), (3/4)



Talk to the students:



You can determine to which documents the model points using the Links panel. To access click Edit > Links. The links document lists all links referenced by the correct document and their status. Use the links panel to Load, Synchronize, Activate/Deactivate, Isolate, or Replace referenced documents. Note: The Parent/Children option will only display if the source document is loaded. You can load the source document using the Links window. You can also click Open the Pointed Document from the contextual menu to open the source document in a separate window.



Managing Multi-Model Links (3/3) Student book reference: Student Guide: Managing Multi-Model links (3/4), (4/4)



Talk to the students: If you no longer want the target document to update changes to the source you can break the link from the contextual menu. Click Isolate to break the link between the source and target document. New Geometrical set is created called ‘Isolated External Reference’ the Isolated element is moved in to this Geometrical set. When changes occur to a the source document, geometry pointing to the linked document will display a red X in its icon. This indicates that the link is not up to date. You can update the link using the links panel. Another way to update a link without opening the Link panel is using the contextual menus. Right click on the solid and click Solid.1 object > Synchronize from the contextual menu. To update all links in a model at the same time, right mouse click on the part and click Part2 object > Synchronize All from the contextual menu. Note that the part is NOT yet fully updated
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CATIA V5 Mechanical Design Expert Your Notes: Exercise Overview Student book reference: Student Guide: Multi-Body Work (Detailed Instructions), Multi-Body Work (Limited Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class. Some will prefer to see you do a demonstration before, some will prefer to struggle with the exercises and then see a demonstration after. A demonstration of the topics covered should include the creation of a multi-model link, a Boolean operation and a modification.



Talk to the students:



As a class discuss what will be involved in completing the exercises. What tools will they need to use? Tell students where they will be saving the models to and where the required start parts are located. State that they are to move from one exercise to the next and complete both exercises and the case study (time permitting).



Case Study: Design Complex Parts Student book reference: Student Guide: Case Study: Design Complex Parts



Talk to the students: Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Have the students begin the exercises and note the time. Assist students as needed with the exercises.



Multi-Body Work (Detailed Instructions): Recap Student book reference: Student Guide: Multi-Body Work: Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Mechanical Design Expert Your Notes: Multi-Body Work (Limited Instructions): Recap Student book reference: Student Guide: Multi-Body Work: Recap



Talk to the students:



Discuss the different tools used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Case Study: Design Complex Parts Recap Student book reference: Student Guide: Case Study: Jewel Case Recap



Talk to the students:



Discuss the objectives of the case study. Review the process used to create the Jewel Case. Ensure the students understand the process used to create the case study before beginning the next lesson.
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CATIA V5 Mechanical Design Expert Your Notes:



Lesson 3: Surface Design Surface Design Student book reference: Student Guide: Surface Design



Talk to the students: Introduce the lesson.



Case Study Student book reference: Student Guide: Case Study: Surface Design



Talk to the students:



Introduce the case study. Review the steps



Access the Surface Design Workbench Student book reference: Student Guide: Access the Surface Design Workbench



Talk to the students:



In this chapter, introduce the generative shape design workbench. Explain and demonstrate what are the tools and containers available



Introduction to Surface Design Student book reference: Introduction to Surface Design



Talk to the students: Objective of the slide: Tell what GSD can do A. GSD offers tools necessary to create shapes complex 3D shapes composed of Wireframe and surfaces geometries B. GSD + Part Design integrated: complete set of modeling capabilities to fully capture the design intent of what you want to do The feature-based approach in GSD workbench offers a productive and intuitive design environment to capture and re-use design methodologies and specifications.
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CATIA V5 Mechanical Design Expert Your Notes: The Generative Shape Design Workbench Student book reference: The Generative Shape Design Workbench



Talk to the students:



Objective of the slide: Gives some characteristics of the workbench As seen on the slide: GSD is perfect to design the plastic parts BUT not only: It can be involved in all industries and goods type Other characteristic: - GSD offers complete set of tools to create mechanical surfaces and so is adapted to advanced shape designers - But GSD remains easy to use : - because philosophy of the tools is not very different from PDG tools For those who come from part design: GSD is easy to handle - specifications of what you do is transparently captured during your work: feel like you are designing explicit shapes BUT: beware: GSD creates ASSOCIATIVE surfaces and curves Data organization very important to avoid loops SO NOT TO FORGET: easy to create things in GSD but: - Everything is captured can lead to heavy models can lead to unnecessary complicated data tricky situations in the parent-children relationship inside the part



Generative Surface Design Access and Interface Student book reference: Accessing the Surface Design Workbench Workbench User Interface



Surface Design



Talk to the students:



Now that we have quickly seen what the workbench is made for We are going to see how to access it and we are going to briefly view its interface



Show the students:



Open a new part. - About the tree: we see different containers Explain that we will see this a little later in the lesson but briefly say that here we have what we call “geometrical sets” - Talk about stacking commands (important in GSD) : demonstrate with simple entity creation - Explain the toolbars



Surface Design Workbench Terminology
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CATIA V5 Mechanical Design Expert Your Notes: Student book reference: Surface Design Workbench Terminology



Talk to the students:



A part is a combination of a PartBody and geometrical sets. A PartBody contains the features used to create a solid. It can also contain surface and wireframe elements. A Geometrical Set contains surface and wireframe elements. Order of creation is not taken into account: You can put any surfacic element you wish in the geometrical set and they need not be in a structured logical way. The order of these elements is not important as their access and their visualization is managed independently without any rule. SO: In a GS, a child feature can exist or can be reordered before the parent feature. gather various features in a same set or sub-sets and organize the specification tree. For example, one GS can be dedicated to contain only wireframes while the other can contain surfaces. An Ordered Geometric Set (OGS) contains surface and wireframe element. The elements in this set are created in a linear manner. OGS can also contain bodies. Bodies allow for the creation of solids within an OGS: In a OGS: the order of the features must respect this update order. For instance: I cannot place a point before a plane in the tree if the point is placed on the plane because the plane is the parent of the point. OGS are equivalent to part design bodies And so (like in bodies): features can be defined in work object OGS help understand the design process of a part Another characteristic of the OGS: Creation features create a new object in the tree and modification features create a new state in an existing object as well as absorb the preceding state(s). Absorbed features are no longer visible nor accessible, as if ' ' masked' 'by their absorbing feature. State that in the example above, Sweep.1 is used to create Join.1 gets absorbed in it.



Show the students: In CATIA, show these elements and explain the insertion of geometrical sets. Show also the manipulations that can be done on the geometrical sets (reorder, change parent ...)
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CATIA V5 Mechanical Design Expert Your Notes: Surface Design Workbench Terminology Student book reference: Surface Design Workbench Terminology



Talk to the students:



A part is a combination of a PartBody and geometrical sets. A PartBody contains the features used to create a solid. It can also contain surface and wireframe elements. A Geometrical Set contains surface and wireframe elements. Order of creation is not taken into account: You can put any surfacic element you wish in the geometrical set and they need not be in a structured logical way. The order of these elements is not important as their access and their visualization is managed independently without any rule. SO: In a GS, a child feature can exist or can be reordered before the parent feature. gather various features in a same set or sub-sets and organize the specification tree. For example, one GS can be dedicated to contain only wireframes while the other can contain surfaces. An Ordered Geometric Set (OGS) contains surface and wireframe element. The elements in this set are created in a linear manner. OGS can also contain bodies. Bodies allow for the creation of solids within an OGS: In a OGS: the order of the features must respect this update order. For instance: I cannot place a point before a plane in the tree if the point is placed on the plane because the plane is the parent of the point. OGS are equivalent to part design bodies And so (like in bodies): features can be defined in work object OGS help understand the design process of a part Another characteristic of the OGS: Creation features create a new object in the tree and modification features create a new state in an existing object as well as absorb the preceding state(s). Absorbed features are no longer visible nor accessible, as if ' ' masked' 'by their absorbing feature. State that in the example above, Sweep.1 is used to create Join.1 gets absorbed in it.



Show the students: In CATIA, show these elements and explain the insertion of geometrical sets. Show also the manipulations that can be done on the geometrical sets (reorder, change parent ...)
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CATIA V5 Mechanical Design Expert Your Notes: Geometrical Set Vs Ordered Geometrical Set Student book reference: Geometrical Set Vs Ordered Geometrical Set



Talk to the students:



To recap what we have seen and what you have manipulated in the previous exercise OGS helps to maintain parent children relationships, but prevents re-using creation features You can reorder the featues in the OGS only by respecting parent child relations GS helps to re-use creation features but scanning of the part is not possible.



Hybrid Design Student book reference: Hybrid Design



Talk to the students:



Explain to students that they have the possibility to mix solid and ordered surfaces features if they choose to work in hybrid mode in GSD. HYBRID CONTAINER: - the bodies ARE by default the containers that will welcome the solids and the surfaces (as seen on the picture). - the container can be an OGS if you insert it at startup the OGS is then inserted in the body (not possible if non hybrid mode)



Surface Design Workbench General Process Student book reference: Surface Design Workbench General Process



Talk to the students: Classical process that will be used during this course



Create the Reference Geometry Student book reference: Student Guide: Create the Reference Geometry



Talk to the students:



In this chapter, we’ll see the tools to create reference geometry and the basic wireframe features.
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CATIA V5 Mechanical Design Expert Your Notes: What is a Reference Geometry? Student book reference: What is a Reference Geometry?



Talk to the students:



Before you start modeling you should create these fundamental elements. - Gives an outline of the model. All the surface elements designed during the modeling process will be based on these reference elements. STABLE SUPPORT: geometry can be dimensioned with respect to the reference elements that are SIMPLE and STABLE and easily REPLACED better stability and adaptability in the model during the design iterations. OUTLINES: In the picture shown the reference elements are used to limit the size of the model and also support the wireframe geometry of the model. NAMING: For Example, a Plane used to limit the sides of the model can be named as ‘Side limiting plane’ and a line used to define the direction of the surface extrude can be named as a ‘direction line’.



Show the students:



DEMONSTRATE the creation of: POINT (DB), EXTREMUMS (diff between polar and basic), LINE (DB), AXIS (Show), PLANES (DB) Create a simple surface based on reference geometry such as limiting plane for the base curve... Show also that parameters can be useful to drive the reference geometry. Name the reference geometry you create consistently to their use (for instance LIMITING PLANE for planes that are limiting the guide curve)



Curve Creation (1/2) Student book reference: Curve Creation (1/2, 2/2)



Talk to the students: The Wireframe Toolbar from the Generative Shape Design workbench can be used to create curves. In GSD, the surfaces are based on curves. And so the shape of the surfaces depends on the shape of the curves. --> You need curves as inputs for the surfaces and the shape of the curves is very important. Quality of the surface depends on the quality of the curves: quality of the curve is important (SEE NEXT SLIDE)
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CATIA V5 Mechanical Design Expert Your Notes: Importance of a Continuous Curve Student book reference: Importance of a Continuous Curve



Talk to the students:



Explain the impact of bad continuity surface in down stream application in a manufacturing industry as follows, Impact on Visual Characteristics of the final part Aesthetics Reflection, smoothness Style features as intended by Designer/Stylist Impact on Mathematical calculations 0 order continuity 2 order continuity 3 order continuity Impact on Manufacturing processes Product should retain their shape - proper stretching requirement should be taken care, Styled features should retain intended shapes, Feature lines like shoulder line or waist line on body side panel, feature lines on hood panel should retain their place (skidding), Bulge effect on flange lines should be avoided, Manufacturability of shapes (Forming of sheet metal, Molded components) etc.



Creating Curves Student book reference: Creating Curves



Talk to the students: Let’s now have a look at all the curves that can be created in GSD



Show the students:



Demonstrate in CATIA the curves creation



Exercise Overview Student book reference: Student Guide: Exercise: Complex Wireframe Creation (Detailed Instructions), Exercise: Splines, Circles and Projections (Detailed Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class.



Talk to the students:



Present the exercises available to practice the skills learned in this part of the lesson.
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CATIA V5 Mechanical Design Expert Your Notes: Complex Wireframe Creation (Detailed Instructions): Recap Student book reference: Student Guide: Exercise: Complex Wireframe Creation Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Splines, Circles and Projections (Detailed Instructions): Recap Student book reference: Student Guide: Exercise Splines, Circles and Projections Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?



Create the Basic Surface Geometry Student book reference: Student Guide: Create the Basic Surface Geometry



Talk to the students:



In this chapter, we’ll see the tools to create basic surfaces such as extrusion or revolution surfaces.



Why Create Surface Geometry? Student book reference: Why Create Surface Geometry?



Talk to the students: Part Design workbench does not allow the creation of shapes when they are too complex + Part Design workbench does not always allow the use of 3D curves as inputs -->In these cases you need to use surfaces. Remember that surfaces have no thickness To get a part with thickness, you need to derive a solid from the surface
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CATIA V5 Mechanical Design Expert Your Notes: Basic Surfaces Student book reference: Creating an Extruded Surface



Talk to the students:



Creating a Cylinder Surface



Here is an overview of the basic surfaces that can be created with GSD: Extruded Surfaces: a profile is extruded in a given direction. You just specify the length. The process is the same as PADS in Part Design Revolution Surfaces: a profile is revolved around an axis. Like a SHAFT in Part Design To create these surfaces, the profile can be an opened profile and it can be a 3D curve.



Show the students: In CATIA, demonstrate the creation of these 3 surfaces



Create the Complex Surface Geometry Student book reference: Student Guide: Create the complex Surface Geometry



Talk to the students:



In this chapter, we’ll see tools to create more complex surfaces such as sweep or blend surfaces.



Computation of Sweep Student book reference: Computation of Sweep



Talk to the students:



Explain the student the computation of the sweep internally. The 3 steps explains the internal computation of the surface. When a profile is swept along the guide curve to generate the surface, sweep internally computes planes normal the spine along the guide curve. The profile to sweep is repeated in all the planes along the guide curve. Thus a surface is generated passing through these profiles which is normal to the plane at any point. So:- The shape of the sweep depends on the planes in which the sections are calculated - The planes depends on the spine The shape of the sweep highly depends on the spine Not only of course: guide and profile also. But spine is really the key concept to understand when we talk about sweep in CATIA V5 because the spine has an impact on: - The sweep shape - The sweep quality
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CATIA V5 Mechanical Design Expert Your Notes: Explicit Sweep Student book reference: Creating Swept Surface – Explicit Subtype Surface – Second Guide



Creating a Swept



Talk to the students: In Generative Shape design using the sweep tool you can sweep a user designed profile in three ways, - Using Reference surface: The guide curve must rely on the surface. Then an axis system positioned on the guide is calculated using the surface section and the normal to surface. The axis system in which the sections of the sweep are calculated along the guide is rotated in regards to the angle you give (DEMONSTRATE: do a rotation of -50deg on the axis system, apply a transformation axis-to-axis to the profile and show that giving an angle of 50deg to the sweep, the sweep passes by the rotated profile) - With two Guide Curves : The profile sweeps along the two guide curves and a surface is generated. You can also specify anchor points for each guide. These anchor points are intersection points between the guides and the profile' s plane or the profile itself, through which the guiding curves will pass. NOTE: the anchor points do not need to be on the profile (DEMONSTRATE) Which can be a good solution to position the profile - With Pulling Direction : This is similar to the sweep using reference surfaces. Here the direction of pulling decides the direction in which the surface would be removed from the mold.



Show the students: Demonstrate the creation of explicit sweep Show how to choose a spine in the dialog box Show the sweep relimiter



Offset Surface Student book reference: Creating an Offset Surface



Talk to the students: Explain that an offset surface is different from a translation in a direction. How is it calculated: A normal is built at each point of the surface and an offset value is measured on this normal. The set of points obtained is the offset surface. Compared to Part Design: As if you were giving a thickness to the surface the offset surface is the obtained face of the solid. As in the picture: repeated offset can be created on the fly.



Show the students:



Demonstrate the creation of an offset surface in CATIA. Show a case where the offset does not work.
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CATIA V5 Mechanical Design Expert Your Notes: Fill Surface Student book reference: Creating a Fill Surface



Talk to the students:



Fill surfaces can be used to fill a gap in a surface. It can also be used to replace a missing cell in a surface. For instance: you import surfaces from V4 and one of the surfaces is missing: there’s a gap in the resulting skin: you have to fill the gap. Fill surface can only be created if the used curves or boundaries defining the limit of the fill are forming a closed contour. Else you will not be able to create the fill. You can also add tangency conditions with adjacent surfaces to ensure the final completed skin tangency continuity



Show the students: Demonstrate the creation of a fill surface You can also show that even if a fill looks triangular (which is never good for a surface), the real cell that is created is in fact a rectangular cell that is relimited with the used curves. To show this: create a triangular fill and un-split it: you will see the rectangular cell



Blend Surface Student book reference: Creating a Blend Surface



Talk to the students:



A blend surface can be created between 2 curves without supporting surfaces But the interest of a blend is to create a continuous connecting surface (point, tangency or curvature continuity) between 2 existing surfaces. The shape of the blend is not driven by a radius (it is not a fillet): it is driven by tensions. Briefly explain what is a tension (if you feel comfortable, you can go to freestyle workbench to display the control points and show that when you increase the tension, the control points are different modifying the tension= increasing the distance between the curve to connect and the first control points line)



Show the students:



Demonstrate the creation of a blend. For further explanations, use curves with vertices and different number of vertices (as in the picture)
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CATIA V5 Mechanical Design Expert Your Notes: Blend Surface: Curves Orientation Student book reference: Blend Surface: Curves Orientation



Talk to the students:



The first point of the first curve is linked to the first point of the second curve. The first point depends on the curve orientation. So if the orientations are different, the first point of the first curve may be opposite to the first point of the second curve. That’s why you get a twist in this case



Show the students: Demonstrate this



Blend Surface: Coupling points Student book reference: Blend Surface: Coupling points



Talk to the students: You can define correspondence between the points and vertices of the two curves to define and control the internal edges of the resulting blends. In the picture: you can see that if we do not define coupling points (ratio used by default), you get to many internal edges So the definition of coupling points is useful to improve the blend



Show the students: Demonstrate the definition of coupling points in CATIA



Multi-Section Surface Student book reference: Creating a Multi-Sections Surface



Talk to the students: A multi-section surface is a surface passing through existing sections. Previously called “loft”. History of the tool: tool originally used to create plane wings (surface passing through the plane wings ribs/sections). Plane wings mock-up (scale 1) were created from these surfaces needed a lot of space these mockup were created in lofts. So the tool was previously called “Loft”. Stress the fact that sections orientation are important not to get a twist (like for blend)



Show the students: Demonstrate the creation of a loft
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CATIA V5 Mechanical Design Expert Your Notes: Multi-Section Surface: Guide Curves and Coupling Points Student book reference: Creating a Multi-Sections Surface



Talk to the students:



Guide curves can be used to drive the shape of the surface. The guide curves have to intersect the sections. Guide curves linking the extremities of the curves are defining the boundaries of the surface. The guide curves linking internal vertices of the sections are defining internal edges of the surface. As for the blend: correspondence between sections vertices (how to get from one to the other) can also be defined using coupling points It can be used to reduce the number of internal edges of the surface.



Show the students: Demonstrate the definition and use of guide curves and coupling points



Exercise Overview Student book reference: Student Guide: Exercise: Simple Surfaces (Detailed Instructions), Exercise: Sweep and Blend (Detailed Instructions), Exercise: Sweep and Fill (Detailed Instructions)



Show the students:



Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class.



Talk to the students:



Present the exercises available to practice the skills learned in this part of the lesson.



Simple Surfaces (Detailed Instructions): Recap Student book reference: Student Guide: Exercise: Simple Surfaces Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Mechanical Design Expert Your Notes: Sweep and Blend (Detailed Instructions): Recap Student book reference: Student Guide: Exercise Sweep and Blend Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Sweep and Fill (Detailed Instructions): Recap Student book reference: Student Guide: Exercise Sweep and Fill Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?



Perform Operations on Surfaces Student book reference: Student Guide: Perform operations on surfaces



Talk to the students:



Once the surfaces are created, we’ll see how to re-limit them, assemble them, fillet them, transform them or heal them.



What are Operations on Surfaces ? (1/2) Student book reference: Why Are Operations on Geometry Needed?



Talk to the students: List the elements and explain briefly what they do



What are Operations on Surfaces ? (2/2) Student book reference: Why Are Operations on Geometry Needed?



Talk to the students: List the elements and explain briefly what they do
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CATIA V5 Mechanical Design Expert Your Notes: Joining Elements Student book reference: Why Do You Need Joining Elements? Exclude Sub-Elements



Joining Elements –



Talk to the students: Join: this operation is creating one single topology from different surfaces. Advantage: only one feature in the tree Simplify the selection. Advantage: some further operations only accept one surface as an input necessary to gather the surfaces in one topology to use them as an input. Surfaces or curves can be joined



Show the students:



Show the checks that are done during the join and stress on the fact that only one feature is in the tree (the original surfaces being hidden) Show also the exclusion of sub-elements if necessary



Healing Elements Student book reference: Healing Elements



Talk to the students:



Heal: creates one single topology (like the join) except that it heals the defects on the surface (gaps or tangency discontinuity) It modifies the surfaces, it does not just creates a topology. Heal can also be used on a single topology to heal defects on internal edges. Healing topology is necessary to be able to use the surface for further applications (to create a solid from it for instance) Explain how to choose the healing parameters correctly



Show the students: Heal: demonstrate the healing and the pre-visualization of the result before validation



Splitting Student book reference: Splitting Elements – Introduction



Splitting Elements



Talk to the students: Here we talk about surfaces. But remember that wireframe can also be split (remember we used it when we saw how to remove a bad area from a curve). Of course in this case: wireframe have to intersect.



Show the students:



Demonstrate the split tool in CATIA V5, stress the fact that used elements must intersect. Show the split of surface with wire, and the split of surface with another surface or a plane Show the choice of the cut surface part to keep
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CATIA V5 Mechanical Design Expert Your Notes: Trimming Student book reference: Trimming Elements – Introduction



Talk to the students:



Trimming Elements



In the split operation, only the split element is processed: the splitting element was just here to specify the part of the split element to keep. With the trim operation: the two elements are re-limited And the result in the tree is one single surface aggregating the 2 limited surfaces The same for surfaces: they have to intersect with their splitting element



Show the students:



Demonstrate the trim and show the difference with the split



Why Use Fillets? Student book reference: Why use fillets ?



Talk to the students:



Many manufacturing process do not accept sharp edges on surfaces You need to remove them Use fillets to replace the sharp edges by a radius driven connection surface. Many types of fillets are available Next slide



Various Types of Fillets Student book reference: Creating a BiTangent Shape Fillet



Talk to the students:



Creating a Tritangent Fillet



A quick overview of all the fillets available Explain what are the differences between these fillets: Shape Fillet: connect 2 separated surfaces with a radius driven connection surface Edge Fillet: remove sharp edges inside an existing topology Variable Fillet: like the edge fillet except that the radius can vary along the edge Face-face Fillet: connect non-adjacent faces of a surface with a fillet Tri-tangent Fillet: create a fillet tangent to 3 adjacent faces of a surface



Show the students:



Demonstrate all these fillets and there options
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CATIA V5 Mechanical Design Expert Your Notes: Extrapolating Elements Student book reference: Extrapolating Elements – Introduction



Talk to the students:



Extrapolating Elements



It is often used to extend an element past another so that later these elements can be trimmed, split, or intersected.



Show the students: demonstrate the extrapolate tool on all the options



Transformations Student book reference: Transformations



Talk to the students: The Translation tool is used to move a selected element. Translation can be made by specifying a direction and distance, selecting start and end points, or using coordinates. The Rotation tool is used to rotate a selected element about an axis. The Symmetry tool is used to create the mirror image of the selected element. The element can be mirrored about a point, line, or plane. The Scaling tool is used to resize a selected element. The element is scaled about a selected point, plane, or planar surface using a scaling factor. The Affinity tool scales the selected element in the X, Y, or Z direction based on a selected axis system. The Axis to Axis tool duplicates and positions selected geometry based on a new axis system.



Show the students:



Demonstrate these tools
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CATIA V5 Mechanical Design Expert Your Notes: Boundary and Extracted Curves Student book reference: Boundary Curves



Extracting a Face from a Surface



Talk to the students:



These tools allow the extraction of curves from surfaces. Boundaries using the Boundary tool. Different propagation types are possible: A- Using the Complete boundary option, the selected edge is continued about the entire surface boundary. B- Using the Point continuity option, the selected edges is continued about the surface boundary until a point discontinuity is met. C- Using the Tangent continuity option, the selected edge is propagated about the surface boundary until a tangent discontinuity is met. D- Using the No propagation option only the selected edge is used to create the boundary curve. Internal edges using the extract tool. Surface cells using the extract tool.



Show the students: Demonstrate these tools



Solidify the Model Student book reference: Student Guide: Solidify the model



Talk to the students:



Once you have a clean surface (topology), you may want to create a surface from it. That’s what this chapter is about



Why Complete the Geometry in Part Design? Student book reference: Why Complete the Geometry in Part Design?



Talk to the students: The hybrid modeling capability of V5 enables the complex surface geometry to shape the solid part. Keep in mind the following key points when solidifying a model: The Part Design workbench is used to produce solid geometry from complex surfaces. The success of the solid creation highly depends on the surface quality (for instance: a gap will prevent the solid from being created) Modifications to the surface geometry are reflected in the solid part.



COPYRIGHT DASSAULT SYSTEMES



54



CATIA V5 Mechanical Design Expert Your Notes: How Can Solids be Created or Manipulated by Surfaces? Student book reference: How Can Solids be Created or Manipulated by Surfaces? Sewing a Surface into a Body



Talk to the students: You can relimit a solid using a surface: SPLIT You can also add thickness to a surface to get a solid: THICK SURFACE You can close a surface if this surface is completely closed OR if it is opened only by a planar hole: CLOSE You can add the solid material contained between the solid and the surface: SEW



Show the students:



Demonstrate these tools



Exercise Overview Student book reference: Student Guide: Exercise: Join, Trim and Transformations (Detailed Instructions), Exercise: Join, Trim and Close Surface (Limited Instructions), Exercise: Join, Trim and Fillet (Detailed Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class.



Talk to the students:



Present the exercises available to practice the skills learned in this part of the lesson.



Case Study: Surface Design Student book reference: Student Guide: Case Study: Surface Design



Talk to the students:



Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Have the students begin the exercises and note the time. Assist students as needed with the exercises.



COPYRIGHT DASSAULT SYSTEMES



55



CATIA V5 Mechanical Design Expert Your Notes: Join, Trim and Transformations (Detailed Instructions): Recap Student book reference: Student Guide: Exercise: Join, Trim and Transformations Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Join, Trim and Close Surface (Limited Instructions): Recap Student book reference: Student Guide: Exercise Join, Trim and Close Surface Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?



Join, Trim and Fillet (Detailed Instructions): Recap Student book reference: Student Guide: Exercise Join, Trim and Fillet Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?



Case Study: Surface Design Recap Student book reference: Student Guide: Case Study: Surface Design Recap



Talk to the students: Discuss the objectives of the case study. Ensure the students understand the process used to create the case study before beginning the next lesson.
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CATIA V5 Mechanical Design Expert Your Notes:



Lesson 4: Analyze and Annotate Parts Analyze and Annotate Parts Student book reference: Student Guide: Analyze and Annotate Parts



Talk to the students: Introduce the lesson.



Case Study Student book reference: Student Guide: Design Intent



Talk to the students:



The model needs to be analyzed: The model needs to be analyzed and scanned to verify that it follows company policy. The model needs to be constrained: The creator of this model incorrectly constrained the holes. You need to make corrections. Notes must be added: Your company policy requires that you make note of any changes that you have made to the part.



Analyze the Part Student book reference: Student Guide: Analyze the Part



Talk to the students: Introduce the step.



Introduction to Part Analysis Student book reference: Student Guide: Introduction to Part Analysis



Talk to the students: Do not go into details. Threads and taps analysis: Use to visualize and obtain information about threads and taps contained in a part. Draft analysis: Use to analyze the ability of a part to be extracted for mold design Surface curvature analysis: Use to analyze high quality surfaces.
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CATIA V5 Mechanical Design Expert Your Notes: Thread and Tap Analysis Student book reference: Student Guide: Thread and Tap Analysis, Analyzing Threads and Taps



Talk to the students: Use the Thread and Tap Analysis tool to quickly retrieve all the information about the threads and taps. The following options are available in the Thread/Tap Analysis dialog box: Describe the available options. Click Apply to display result. Note that the result is not stored.



Draft Analysis (1/2) Student book reference: Student Guide: Draft Analysis, Analyzing Drafts (1/3)



Talk to the students:



For mold design, drafts need to be analyzed in order to determine the feasibility of part extraction from the mold. Need to select View > Render Style > Customized View and check the Material option in order to visualize colors. Describe the steps and the options. Select the analysis mode desired: Quick analysis mode, Full analysis mode. Adjust the colors and the color range values: Double-click on the color to edit the color, double-click on the range value to edit the value.
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CATIA V5 Mechanical Design Expert Your Notes: Draft Analysis (2/2) Student book reference: Student Guide: Analyzing Drafts (2/3), (3/3)



Talk to the students:



Check the On The Fly option to be able to perform a local analysis based upon the location of the pointer. The local analysis contains the following features: The displayed value indicates the angle between the draft direction and the tangent to the surface at the current point. The green arrow represents the normal to the surface at the location of the pointer. The red arrow represents the draft direction. The blue arrow represents the tangent at the location of the pointer. Use the button shown to define a new draft direction. A compass giving the current draft direction is displayed. The draft direction is the w axis of the compass. Double-click on the compass to define the orientation of the compass more precisely. The red area displays all the areas that cannot be drafted with the current draft direction. Click OK when done.



Curvature Analysis Student book reference: Student Guide: Curvature Analysis, Performing a Surface Curvature Analysis



Talk to the students: The Curvature Analysis tool is generally used to help model high quality surfaces by detecting faults that may exist in a surface. There are several types of analysis available. Gaussian measures the mean curvature value, Minimum measures the minimum curvature value, Maximum measures the maximum curvature value, Inflection Area identifies the curvature orientation, Limited checks if a tool with an end radius can mill the part. Describe the steps. Adjust the color ranges by double-clicking on the values to be adjusted.
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CATIA V5 Mechanical Design Expert Your Notes: Exercise Overview Student book reference: Student Guide: Curvature Analysis (Detailed Instructions), Draft Analysis (Detailed Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class.



Talk to the students:



Present the exercises available to practice the skills learned in this part of the lesson.



Curvature Analysis (Detailed Instructions): Recap Student book reference: Student Guide: Curvature Analysis (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Draft Analysis (Detailed Instructions): Recap Student book reference: Student Guide: Draft Analysis (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?



Create 3D Constraints Student book reference: Student Guide: Create 3D Constraints



Talk to the students:



Introduce the step.
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CATIA V5 Mechanical Design Expert Your Notes: 3D Constraints Student book reference: Student Guide: What is a 3D Constraint?, Why Use a 3D Constraint?



Talk to the students: A 3D constraint is created on 3D geometry. Both geometric and dimensional 3D constraints can be created. 3D constraints are created using the same method as sketcher constraints. Regular: A dimension is a constraint that drives an aspect of the part. It can be modified, linked and driven if necessary. Reference: Cannot be modified. Will be created in place of a regular constraint if there is already a dimension constraining the same aspect of the part. In the example, the pad on the left was created before the left hole that goes through it. The left hole was positioned using a sketch and the pad is not positioned at all. If the length of the overall part is increased by 50mm, then the hole will be shifted left by 50 mm, the pad, however, remains in its current position. If a 3D constraint is created to keep the side of the pad a set distance to the center of the hole, then a change in the overall length of the part still allows for the design intent of the part to be maintained. Option B is the most common use of this function and would be used when positioning a body (for example geometry representing tooling) with respect to the rough part.



Creating a 3D Constraint Student book reference: Student Guide: Creating a 3D Constraint



Talk to the students: Describe the steps. The Constraints Defined in dialog Box icon only becomes active once the geometry has been selected. This is the same behavior as for sketch constraints. In the example shown below, a 3D constraint was added for the hole on the right, but it is shown as a reference dimension. The reason for this is because the position of the hole on the right has already been defined in the positioning sketch of the hole.
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CATIA V5 Mechanical Design Expert Your Notes: Exercise Overview Student book reference: Student Guide: 3D Constraints (Detailed Instructions)



Show the students:



Demonstrate the topics learned in this part of the lesson before or after students work on the exercises.



Talk to the students: Tell students where they will be saving the models to and where the required start parts are located.



3D Constraints (Detailed Instructions): Recap Student book reference: Student Guide: 3D Constraints (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Annotate the Part Student book reference: Student Guide: Annotate the Part



Talk to the students:



Introduce the step.



Creating a Text with Leader Student book reference: Student Guide: Text with Leader, Creating a Text with Leader



Talk to the students: To provide information regarding the surface treatment, for example. The text can also be displayed on the part drawing. The view and note is added in the Annotation Set branch in the specification tree. Step 4: Drag the arrow or square points.
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CATIA V5 Mechanical Design Expert Your Notes: Modifying a Text with Leader Student book reference: Student Guide: Modifying a Text with Leader



Talk to the students:



Modify the text itself by double-clicking it and using the Text Editor dialog box. Modify the properties of the text, such as the font style, font size, or graphics, by selecting Properties from the contextual menu of the text with leader. Modify the text with leader using the additional options in the contextual menu.



Creating a Flag Note with Leader (1/2) Student book reference: Student Guide: Flag Note with Leader, Creating a Flag Note with Leader (1/2)



Talk to the students:



A flag note with a leader can be attached to a part in order to give information regarding a feature, surface, or the part itself. This flag is a hyperlink that can launch any document, such as a presentation, a Microsoft Excel spreadsheet or an HTML page. Step 4: The Link to File dialog box will appear. Step 5: Complete by selecting Open.



Creating a Flag Note with Leader (2/2) Student book reference: Student Guide: Creating a Flag Note with Leader (2/2)



Talk to the students: Adjust the size, shape, and position of the flag note with leader. The flag note will be added to the notes node beneath the annotation set node.



Using a Flag Note with Leader Student book reference: Student Guide: Using a Flag Note with Leader
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CATIA V5 Mechanical Design Expert Your Notes: Modifying a Flag Note with Leader Student book reference: Student Guide: Modifying a Flag Note with Leader



Talk to the students:



Modify the text itself by double-clicking on it and using the Text Editor dialog box. Modify the properties of the text, such as the font style, font size, or graphics, by selecting Properties from the contextual menu of the text with leader. Modify the flag note with leader using the additional options in the contextual menu.



Repositioning 3D Annotations Student book reference: Student Guide: Repositioning 3D Annotations



Talk to the students:



Use the handles to reposition text with leaders and flag note with leaders. B. Use the top and bottom handles to move the annotation up or down as well as to adjust the overall width of the annotation box. C. Use the middle handles to adjust only the width of the annotation box.



Exercise Overview Student book reference: Student Guide: 3D Annotations (Detailed Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises.



Talk to the students:



As a class discuss what will be involved in completing the exercises. What tools will they need to use? Tell students where they will be saving the models to and where the required start parts are located. State that they are to complete the exercise before moving on to the case study (time permitting).
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CATIA V5 Mechanical Design Expert Your Notes: Case Study: Analyze and Annotate Parts Student book reference: Student Guide: Case Study: Analyze and Annotate Parts



Talk to the students:



Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Have the students begin the exercises and note the time. Assist students as needed with the exercises.



3D Annotations (Detailed Instructions): Recap Student book reference: Student Guide: 3D Annotations (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slide after the students have attempted the exercise. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Case Study: Analyze and Annotate Parts Recap Student book reference: Student Guide: Case Study: Analyze and Annotate Parts Recap



Talk to the students:



Discuss the objectives of the case study. Ensure the students understand the process used to create the case study before beginning the next lesson.
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CATIA V5 Mechanical Design Expert Your Notes:



Lesson 5: Sharing Information Sharing Information Student book reference: Student Guide: Sharing Information



Talk to the students: Introduce the lesson



Case Study Student book reference: Student Guide: Case Study: Sharing Information



Talk to the students:



Introduce the case study. Review the steps



Create a PowerCopy Student book reference: Student Guide: Create a PowerCopy



Talk to the students:



Introduce the step.



What Is a PowerCopy? Student book reference: Student Guide: What Is a Power Copy?



Talk to the students: A Power Copy consists of a group of one or more features that can be used in multiple models. A Power Copy differs from a typical copy because it enables you to modify feature parameters when creating it in its new location. The feature parameters are driven by inputs and parameters. Select the parameters such as the height and depth of a feature in order to be able to make modifications during instantiation.
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CATIA V5 Mechanical Design Expert Your Notes: Creating a PowerCopy (1/3) Student book reference: Student Guide: Creating a Power Copy (1/3)



Talk to the students:



Click Insert > Knowledge Templates > Power Copy. The Power Copy Definition dialog box opens at the Definition tab where you can customize the name of the Power Copy and select the features to include. Select the features to include in the Power Copy from the specification tree. As you select features, they appear on the selected components window. Their respective references determine the inputs that are required to place the Power Copy.



Creating a PowerCopy (2/3) Student book reference: Student Guide: Creating a Power Copy (2/3)



Talk to the students:



On the Inputs tab, you can create custom names for the inputs using the Name field. Descriptive names can make placing the Power Copy more intuitive. On the Parameters tab, you can specify variable parameters. These are parameter values that you wish to make modifiable when placing the Power Copy. To make a parameter variable, select the parameter in the list and select the Published option.



Creating a PowerCopy (3/3) Student book reference: Student Guide: Creating a Power Copy (3/3)



Talk to the students: On the Properties tab, you have the ability to customize. You can also add a preview of the Power Copy to help identify the geometry. Click OK to finish. A Power Copy node in the tree will appear with the Power Copy itself below.



PowerCopy Tools Student book reference: Student Guide: Power Copy Tools
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CATIA V5 Mechanical Design Expert Your Notes: Saving a PowerCopy Student book reference: Student Guide: Saving a Power Copy



Talk to the students:



When creating an instantiation, reference is made to an existing document, either a catalog or existing CATPart.



Saving a PowerCopy in a Catalog (1/2) Student book reference: Student Guide: Saving a Power Copy in a Catalog (1/2)



Talk to the students:



Save the model if it has not been already saved. Select Insert > Knowledge Templates > Save in Catalog….The Catalog save dialog box appears. Select the button shown to specify an alternate or new catalog in which to save the Power Copy. Either enter a new name in the File name field to create a new catalog. Select Open to finish creating the catalog. Browse to an existing catalog. Select OK from the Catalog save dialog box. The Power Copy will be saved to the catalog.



Saving a PowerCopy in a Catalog (2/2) Student book reference: Student Guide: Saving a Power Copy in a Catalog (1/2)



Talk to the students: The full path and catalog name was in the Catalog save dialog box. Select File > Open. The File Selection dialog box appears. Browse and select the catalog to open. Expand the tree and double-click to activate the desired node that contains the Power Copy. Select the Preview tab.



Instantiating a PowerCopy Student book reference: Student Guide: Instantiating a Power Copy
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CATIA V5 Mechanical Design Expert Your Notes: Instantiating a PowerCopy from a Document (1/2) Student book reference: Student Guide: Instantiating a Power Copy from a Document (1/4), (2/4)



Talk to the students: Describe the steps. Click Insert > Instantiate From Document….. Select the CATIA document that contains the Power Copy. Click Open to complete the selection. The Insert Object dialog box appears. Select the new references for the Power Copy inputs. Once references have been selected, the Parameter button will become available.



Instantiating a PowerCopy from a Document (2/2) Student book reference: Student Guide: Instantiating a Power Copy from a Document (3/4), (4/4)



Talk to the students: 4. The Parameters dialog box appears with the parameters that were published during the definition of the power copy. Adjust the parameter values to modify the Power Copy instance. Select the Create formulas button to create automatic formulas that equate a parameter in the Power Copy with a parameter in the destination model. A formula will only be created if there is a parameter in the destination model with an identical name and type to the one in the Power Copy. 6. The Power Copy instance will appear in the specification tree as regular features that can be modified. There is no link to the Power Copy.



Inserting a PowerCopy from a Catalog (1/2) Student book reference: Student Guide: Inserting a Power Copy from a Catalog (1/3), (2/3)



Talk to the students: Steps 2, 3, 4. Use file browser to locate and select new catalog file. Steps 5, 6 Double click on icon.
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CATIA V5 Mechanical Design Expert Your Notes: Inserting a PowerCopy from a Catalog (2/2) Student book reference: Student Guide: Inserting a Power Copy from a Catalog (2/3), (3/3)



Talk to the students:



Double click to open. The inputs required to place the Power Copy are listed, and a preview of the previous reference is displayed. For this example, the required reference is a surface. Select the corresponding face on the current model. Verify that the direction of the arrow is correct.



Difference between a PowerCopy and a User Feature Student book reference: Student Guide: Difference between a Power Copy and a User Feature



Talk to the students:



The main difference between a Power Copy and a user feature is seen after the instantiation takes place. An instantiation of a Power Copy includes all the design specifications A user feature hides the design specifications to preserve confidentiality of the feature. Describe the example.



Exercise Overview Student book reference: Student Guide: Power Copy (Detailed Instructions), Power Copy and Catalog (Limited Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class.



Talk to the students:



Present the exercises available to practice the skills learned in this part of the lesson.
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CATIA V5 Mechanical Design Expert Your Notes: PowerCopy (Detailed Instructions): Recap Student book reference: Student Guide: Power Copy (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



PowerCopy and Catalog (Limited Instructions): Recap Student book reference: Student Guide: Power Copy and Catalog (Limited Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Create Parameters and Formulas Student book reference: Student Guide: Create Parameters and Formulas



Talk to the students: Introduce the step.



Introduction to CATIA V5 Knowledgeware Student book reference: Student Guide: Introduction to CATIA V5 Knowledgeware



Talk to the students: CATIA V5 Knowledgeware is a set of tools intended to assist engineering decisions. It automates design and detects predefined design errors for maximum productivity. You can easily generate, for example, four different wheels from the same CATIA file.



Accessing Common Knowledge Tools Student book reference: Student Guide: Accessing Common Knowledge Tools
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CATIA V5 Mechanical Design Expert Your Notes: Terminology Student book reference: Student Guide: Terminology



Talk to the students:



Describe terms.



Knowledgeware Settings (1/2) Student book reference: Student Guide: Knowledgeware Settings (1/4), (2/4)



Talk to the students: Parameters and relations can be displayed in the specification tree of a part OR a product. Different settings have to be defined to display parameters and relations at the part or product level. Describe steps.



Knowledgeware Settings (2/2) Student book reference: Student Guide: Knowledgeware Settings (3/4), (4/4)



Talk to the students:



The values of parameters and formulas can be displayed in the tree. The back quote symbol can be set to surround parameter names. Design tables can be set to automatically synchronize. Describe steps. Some relations, such as those that use measures, will require the use of extended language libraries. Activate the Load extended language libraries option in order to be able to select the specific libraries to load. Activate All packages to load all the packages or select the individual packages to be loaded: Deactivate All packages or select the packages to be loaded. Select the rightward arrow button. The package should be transferred over to the Package to load list.



Introduction to Common Knowledge Tools Student book reference: Student Guide: Introduction to Common Knowledge Tools
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CATIA V5 Mechanical Design Expert Your Notes: What are Parameters? Student book reference: Student Guide: What are Parameters? (1/2), (2/2)



Talk to the students:



Parameters are used to describe the properties of a model. They can be defined by relations or used as arguments in a relation. There are two kinds of parameters: intrinsic and user. Describe intrinsic and user parameters, and the types of intrinsic parameter (length, Boolean, … ). User parameters can be defined at different levels: Assembly level, Part level, Feature level. Different parameter types such as real, integer, string, Boolean, length, and mass. User parameters can be defined to hold only pre-determined values, such as from 1 to 10, or they can be set to hold any value matching the parameter type.



Why Use User Parameters? Student book reference: Student Guide: Why Use User Parameters?



Creating a User Parameter with a Single Value Student book reference: Student Guide: Creating a User Parameter with a Single Value



Talk to the students:



Describe steps.



Creating a User Parameter with Multiple Values Student book reference: Student Guide: Creating a User Parameter with Multiple Values



Talk to the students: Describe steps. Step 5. The value will move to the bottom list. Continue to enter additional values for which the parameter will allow.
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CATIA V5 Mechanical Design Expert Your Notes: Editing a User Parameter Student book reference: Student Guide: Editing a User Parameter (1/2), (2/2)



Talk to the students:



Describe steps to edit. Review the contextual menu options.



Formulas Student book reference: Student Guide: What are Formulas?, Why Use Formulas?



Talk to the students:



What are Formulas? Formulas are relations used to define or constrain any parameter. They can be defined with parameters, operators, and functions. The left part of the relation is the parameter to constrain and the right part is a statement. Once it has been created, a formula can be manipulated like any other feature from its contextual menu. Why Use Formulas? To define relations between parameters. A. The height of a cube can be made equal to the length and width of the cube, for example, so that only one of the parameters needs to be modified for all the values to change. D. A formula can calculate a part’s wetted area, for example, by using the function, smartWetarea.



Accessing the Formula Editor Student book reference: Student Guide: Accessing the Formula Editor



Talk to the students:



A. Double-click on the parameter in the parameter list. B. Select Edit formula from the contextual menu. C. Select Edit formula from the contextual menu.
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CATIA V5 Mechanical Design Expert Your Notes: Creating a Formula Student book reference: Student Guide: Creating a Formula



Talk to the students:



1. The Formulas dialog box appears. 2. The Formula Editor dialog box appears. You can also use the Add Formula button. 3. Selecting a feature in the geometry area or in the specification tree will enter the feature in the formula editor field. Use the parameter filters to narrow the parameter list displayed. Manually fill in the right side of the formula. Use the dictionary to help create the desired formula. 4. Click OK to confirm the creation of the formula. 5. The formula will be added to the tree. The Incremental option allows you to display only the parameters of the feature selected in the specifications tree.



Using Functions in Formulas Student book reference: Student Guide: Using Functions in Formulas



Talk to the students:



Use the CATIA Knowledge Advisor Programming Guide for more information on how to use functions.



Creating a Formula Which Uses a Function Student book reference: Student Guide: Creating a Formula which uses a Function



Talk to the students:



3. Double-click on length (Curve, Point, Boolean): Length. The length function is added to the formula editor field. 4. Each argument of the function needs to be filled in. Ensure the pointer is positioned where the argument is intended to be entered, and then select the corresponding feature in the tree. For arguments that are integers or Booleans, type in the value. 5. A message box may appear asking if the relation is to be automatically updated with global update. Generally, select Yes.



Editing a Formula Student book reference: Student Guide: Editing a Formula
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CATIA V5 Mechanical Design Expert Your Notes: Create a Design Table Student book reference: Student Guide: Create a Design Table



Talk to the students:



Introduce the step.



Design Tables Student book reference: Student Guide: What Is a Design Table?, Why Use a Design Table?



Talk to the students:



What Is a Design Table? The purpose of the design table is to drive the parameters of a CATIA document from external values. Why Use a Design Table? Review list. Describe changes in example.



Creating a Design Table Student book reference: Student Guide: Creating a Design Table (1/2), (2/2)



Talk to the students: 1. The Creation of Design Table dialog box appears. 2. Select OK. 3. Use the arrows to add them to the list. Select OK. 4. Define the storage location of the design table. Select Save.
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CATIA V5 Mechanical Design Expert Your Notes: Creating a Design Table with an Existing File Student book reference: Student Guide: Creating a Design Table with an Existing File (1/2), (2/2)



Talk to the students: 1. The Creation of Design Table dialog box appears. 2. Select OK. 3. This contains the data for the design table. Select Open. 4. Select Yes to automatically associate columns of the external file and parameters in the CATIA document. This is the simplest case. We will cover the subject Managing Design Table Associations next. A. Automatic association occurs between parameters from the CATIA document and columns of the external file when they have identical spelling. Whether text is upper or lower case and whether blank spaces exist makes a difference. B. In the external file, ensure the units are specified in the external file. If this is not done, CATIA assumes the international system is desired, such as using meters for length. C. If the external file is a text file, ensure only one tab space exists between the desired columns.



Managing Design Table Associations Student book reference: Student Guide: Managing Design Table Associations (1/2), (2/2)



Talk to the students:



The associations between driven parameters of a design table and driving parameters of an external file can be changed if they are not correctly linked or used. D. Create user parameters having the same name as columns that are not yet associated. The association is automatic. E. Associate the parameter and the column that are selected. G. Button to rename associated parameters with the names of their associated columns.



Using a Design Table Student book reference: Student Guide: Using a Design Table



Talk to the students:



Step 2. You can double-click to automatically apply the selected configuration.
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CATIA V5 Mechanical Design Expert Your Notes: Selecting Parameters Student book reference: Student Guide: Selecting Parameters, Filtering Parameters



Talk to the students:



Parameters need to be selected in order to use them in a statement, a design table, or simply to edit it. There are several ways to select a parameter. D. Double-click on parameter. Large parts and assemblies contain many parameters. Finding the desired one can be more difficult without filtering the parameter list. B. If you select a feature (either in the specification tree or in the graphic zone, the associated constraints (parameters) will be displayed).



Exercise Overview Student book reference: Student Guide: Design Table (Detailed Instructions), Design Table and Parameters (Detailed Instructions)



Show the students:



Demonstrate the topics learned in this part of the lesson before or after students work on the exercises.



Talk to the students: Tell students where they will be saving the models to and where the required start parts are located.



Design Table (Detailed Instructions): Recap Student book reference: Student Guide: Design Table (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Mechanical Design Expert Your Notes: Design Table and Parameters (Detailed Instructions): Recap Student book reference: Student Guide: Design Table and Parameters (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Create a Catalog Student book reference: Student Guide: Create a Catalog



Talk to the students: Introduce the step.



Catalogs Student book reference: Student Guide: What is a Catalog?, Accessing the Workbench



Talk to the students:



A catalog is a set of features or components that are designed to be used as a library of information. You can retrieve these stored items and avoid having to recreate geometry that is frequently used. C. File > Open, select a catalog, click Open.



User Interface Student book reference: Student Guide: User Interface, User Interface: Commands



Talk to the students:



A. Also called the catalog navigator. Do not go into detail.
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CATIA V5 Mechanical Design Expert Your Notes: Terminology Student book reference: Student Guide: Terminology (1/2), (2/2)



Talk to the students:



A. A Catalog may contain ISO standard parts, for example. Catalogs are made-up of chapters and families. B. All entities within a Chapter called Pins, for example, should be a pin. Chapters are made-up of chapters and families. C. All entities in a Family called Split_Pin, for example, should be a type of split pin. D. A keyword is used to aid in finding the desired entity. Keywords include name, type, diameter, and length. Use keywords in a query to locate a component. E. Such as a V5 CATPart, V5 CATProduct, V5 power copy, and V4 model.



Creating a Catalog Student book reference: Student Guide: Creating a Catalog (1/2), (2/2)



Talk to the students: Catalogs can be created manually or interactively. B. Recall that a catalog can be created interactively when a power copy is saved in a catalog. A catalog can also be created interactively for 2D components on a detail sheet in a CATDrawing. Describe manual creation. Catalogs can also be created using Start > Infrastructure > Catalog Editor.



Creating Chapters and Families Student book reference: Student Guide: Creating Chapters, Creating Families



Talk to the students:



A chapter will reference other chapters or families. 1. Double-click on the chapter into which the new chapter is to be added. This will activate the existing chapter. A family will reference CATIA documents or features. You cannot create a chapter within a family. 1. Double-click on the chapter into which the new family is to be added. This will activate the existing chapter.
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CATIA V5 Mechanical Design Expert Your Notes: Creating Keywords Student book reference: Student Guide: Creating Keywords



Talk to the students:



Step 7. Specify a discrete list of values by checking the option, clicking OK in the Keyword Definition dialog box. Enter the values.



Creating Components Student book reference: Student Guide: Creating Components



Talk to the students:



Describe the steps. The Select external feature button allows you to select PowerCopies or details to be added to the family. In the Preview tab, select the Local preview option to reference a document in the catalog.



Part Family Components Student book reference: Student Guide: Part Family Components



Talk to the students: Part family components are sets of components generated from a single part that has several configurations. The configurations are based upon a design table. For each configuration described in the design table, a part family component will be created. In the Design Table where all the configurations are defined, a column describing the PartNumber is mandatory. A keyword will be created for each column header in the original table. A preview of each configuration will be displayed in the Preview tab.



Adding a Part Family Student book reference: Student Guide: Adding a Part Family



Talk to the students: Describe the steps.
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CATIA V5 Mechanical Design Expert Your Notes: Adding a Part Family Component Student book reference: Student Guide: Adding a Part Family Component



Talk to the students:



Describe the steps.



How Do I Resolve a Part Family Component? Student book reference: Student Guide: Resolving Part Families, How Do I Resolve a Part Family Component?



Talk to the students:



Resolved family components are stored in the directory specified under Tools > Options > Infrastructure > Catalog Editor > Catalogs tab.



Adding a Link to Another Catalog Student book reference: Student Guide: Adding a Link to Another Catalog



Talk to the students:



The linked object will be displayed in the catalog navigator along with the objects within it, such as sub-chapters and families. Any modifications made to the linked object or its contents will be reflected in all the catalogs that have a link to that object.



Catalog Browser Student book reference: Student Guide: Catalog Browser



Talk to the students: You can view and sort the descriptions of the objects. The tool can be accessed from several workbenches with the Open Catalog icon.
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CATIA V5 Mechanical Design Expert Your Notes: Browsing a Catalog Student book reference: Student Guide: Browsing a Catalog



Talk to the students:



1. Click the Open Catalog icon. This icon is located in the Tools toolbar. 3. The chapters at the top level of the catalog are displayed. 4. Chapters and families that exist in the current chapter are displayed. Use the Back to father chapter icon to go up one level in the catalog. Click the Table button to show or hide the descriptions table.



Inserting a Component from a Catalog (1/2) Student book reference: Student Guide: Inserting a Component from a Catalog (1/2)



Talk to the students: Describe the steps.



Inserting a Component from a Catalog (2/2) Student book reference: Student Guide: Inserting a Component from a Catalog (2/2)



Talk to the students: Describe the steps.



Performing Queries Student book reference: Student Guide: Performing Queries (1/2), (2/2)



Talk to the students:



Catalogs can contain a large number of objects. Use queries to narrow down the number of items displayed and only show the relevant objects. 4. PartName *= GRADE_A, for example, displays only objects with the text, GRADE_A, anywhere in the PartName, d_dia == 24mm displays only objects that have the value of 24mm for d_dia. 5. More than one condition can be specified. Only objects that satisfy all the specified filters will be displayed in the list.
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CATIA V5 Mechanical Design Expert Your Notes: Exercise Overview Student book reference: Student Guide: Catalog (Detailed Instructions), Catalog Modification (Detailed Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises.



Talk to the students:



As a class discuss what will be involved in completing the exercises. What tools will they need to use? Tell students where they will be saving the models to and where the required start parts are located. State that they are to complete the exercise before moving on to the case study (time permitting).



Case Study: Sharing Information Student book reference: Student Guide: Case Study: Sharing Information



Talk to the students:



Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Have the students begin the exercises and note the time. Assist students as needed with the exercises.



Catalog (Detailed Instructions): Recap Student book reference: Student Guide: Catalog (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Mechanical Design Expert Your Notes: Catalog Modification (Detailed Instructions): Recap Student book reference: Student Guide: Catalog Modification (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Case Study: Sharing Information Recap Student book reference: Student Guide: Case Study: Sharing Information Recap



Talk to the students: Discuss the objectives of the case study. Ensure the students understand the process used to create the case study before beginning the next lesson.
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CATIA V5 Mechanical Design Expert Your Notes:



Lesson 6: Assembly Design Assembly Design Student book reference: Student Guide: Assembly Design



Talk to the students: Introduce the lesson.



Case Study Student book reference: Student Guide: Case Study: Assembly Design



Talk to the students:



Introduce the case study. Review steps



Manage the Product Structure Student book reference: Student Guide: Manage the Product Structure



Talk to the students:



Introduce the step.



What are Links Between Product Components? Student book reference: Student Guide: What are Links Between Components in a Product?



Talk to the students:



Links are maintained between all related CATProducts, CATParts, cgr files, and documents (.txt and .xls files) such as Design tables and hyperlinks.



Why Manage Links? Student book reference: Student Guide: Why Manage Links?



Talk to the students:



Using the Links or the Desk command, you can perform a number of tasks related to managing the product structure of a product.
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CATIA V5 Mechanical Design Expert Your Notes: The File Desk command Student book reference: Student Guide: Accessing File Desk Command



Talk to the students:



Describe the product structure, child components



Managing Links using the Desk command Student book reference: Student Guide: Managing Links of a Product Using File Desk (1/2), (2/2)



Talk to the students:



Use the contextual menu, right mouse click on the desired component in the tree. Review possibilities using pop-up menu. When an unloaded document points to other documents, the pointed documents are also unloaded. When unloading a part that belongs to several products, the Unload command applies to all the instances of the part. Use the Unload Management toolbar to unload several documents in the assembly at one time.



Re-establishing Broken Links using the Desk command Student book reference: Student Guide: Re-establishing Broken Links using the Desk Command



Talk to the students: 1. The Open dialog box appears and the broken link is displayed in the specification tree.



Managing Links using Edit Links command (1/2) Student book reference: Student Guide: Accessing Edit Links Command, Managing Links of a Product Using Edit Links (1/2)



Talk to the students:



First activate the document for which you want to Edit > Links. Describe the options. C. Deactivating a component will suppress the synchronization of linked elements during part update.
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CATIA V5 Mechanical Design Expert Your Notes: Managing Links using Edit Links command (2/2) Student book reference: Student Guide: Managing Links of a Product Using Edit Links (2/2)



Talk to the students:



D. The option will also re-route any links to the pointed document that may exist.



What is Generating a CATPart from a product? Student book reference: Student Guide: What is Generating a CATPart from a product?



Talk to the students:



The Generate CATPart from Product tool is used to create a non associative CATPart file The result consists of all shown and active nodes in an assembly.



Generating a CATPart from a product Student book reference: Student Guide: Generating a CATPart from a product (1/2), (2/2)



Talk to the students: Describe steps. The new CATPart file is created in a new window. Any components that were hidden in the original assembly are not added to the new CATPart file. The bodies in the new CATPart are named using the path to instance in the reference product.



Create Flexible Sub- Assemblies Student book reference: Student Guide: Create the Flexible Sub- Assembly



Talk to the students: Introduce the step.
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CATIA V5 Mechanical Design Expert Your Notes: What is a Flexible Sub-assembly? Student book reference: Student Guide: Flexible Sub-Assembly, What is a Flexible Subassembly?



Talk to the students: Normally, if one of the sub-assembly instances is modified, then the other instances of that sub-assembly will also be modified automatically in the same manner. The sub-assembly is said to be rigid. By changing a sub-assembly instance from rigid to flexible, its configuration be modified independently from the other instances of the same sub-assembly.



Making a Sub-assembly Flexible Student book reference: Student Guide: Making a Sub-assembly Flexible



Talk to the students:



2. Or use contextual menu. 3. Indicated by a purple gear in the specification tree.



Positioning Components of a Flexible Sub-assembly (1/2) Student book reference: Student Guide: Positioning Components of a Flexible Subassembly (1/2)



Talk to the students: Assuming there are no constraints between any components



Positioning Components of a Flexible Sub-assembly (2/2) Student book reference: Student Guide: Positioning Components of a Flexible Subassembly (2/2)



Talk to the students: In the examples shown, a contact constraint is applied between the bottom of the clamp sub-assembly and the bottom of the clamp pad. Rigid sub-assembly: The entire sub-assembly is moved. Flexible sub-assembly: The rest of the flexible sub-assembly remains in the original positions.
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CATIA V5 Mechanical Design Expert Your Notes: What is Mechanical Structure? Student book reference: Student Guide: What is Mechanical Structure?



Talk to the students:



There are two types of structures that can be used when dealing with flexible sub-assemblies. Components that can be constrained are shown on the same level. The components and constraints of the flexible sub-assemblies are considered as direct children of the root assembly in this tree.



Viewing the Mechanical Structure Tree Student book reference: Student Guide: Viewing the Mechanical Structure Tree



Talk to the students: 3. Based upon the selection, either the mechanical structure for the instance component or the reference component will be displayed. Reference component shows assembly levels.



Modifying Constraints of Flexible Sub-assemblies (1/2) Student book reference: Student Guide: What Can Be Overloaded in a Flexible Subassembly?, Modifying Constraints of Flexible Sub-assemblies (1/3)



Talk to the students:



The numerical value, activity status, orientation, and the driven/driving property can be overloaded to modify the assembly without affecting other instances. Describe the steps.



Modifying Constraints of Flexible Sub-assemblies (2/2) Student book reference: Student Guide: Modifying Constraints of Flexible Sub-assemblies (2/3), (3/3)



Talk to the students: Describe the steps.
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CATIA V5 Mechanical Design Expert Your Notes: Managing Flexible Sub-assemblies (1/3) Student book reference: Student Guide: Managing Flexible Sub-assemblies (1/5), (2/5)



Talk to the students:



Using an example as shown. Describe the two assembly levels.



Managing Flexible Sub-assemblies (2/3) Student book reference: Student Guide: Managing Flexible Sub-assemblies (3/3)



Talk to the students: Using an example as shown. Describe the two assembly levels.



Managing Flexible Sub-assemblies (3/3) Student book reference: Student Guide: Managing Flexible Sub-assemblies (4/5)



Talk to the students: Describe the possibilies. Ass_Level1: If a change is made to any of the constraints, the other instances will still remain the same. In the example, all three instances of Ass_Level1 are shown as flexible.



Propagating Position to Reference (1/2) Student book reference: Student Guide: Propagating Position to Reference (1/2)



Talk to the students:



Applying the Propagate Position to Reference option will result in the rigid instances of the same referenced assembly inheriting the same constraints as the flexible assembly.
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CATIA V5 Mechanical Design Expert Your Notes: Propagating Position to Reference (2/2) Student book reference: Student Guide: Propagating Position to Reference (2/2)



Talk to the students:



Describe steps. In the example, the displayed constraint is changed from 0mm to 1mm in Base (Base.3). Select XXX.XX object > Propagate position to reference from the contextual menu of the flexible sub-assembly. If Base (Base.2) for example, was flexible, then it would not adopt the position of Base (Base.3).



Exercise Overview Student book reference: Student Guide: Desk and Product to Part (Detailed Instructions), Flexible Sub-Assembly (Limited Instructions), Desk and Flexible Sub-Assembly (Limited Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class.



Talk to the students: Present the exercises available to practice the skills learned in this part of the lesson.



Desk and Product to Part (Detailed Instructions): Recap Student book reference: Student Guide: Desk and Product to Part (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students:



Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Mechanical Design Expert Your Notes: Flexible Sub-Assembly (Limited Instructions): Recap Student book reference: Student Guide: Flexible Sub-Assembly (Limited Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Desk and Flexible Sub-Assembly (Limited Instructions): Recap Student book reference: Student Guide: Desk and Flexible Sub-Assembly (Limited Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Analyze the Assembly Student book reference: Student Guide: Analyze the Assembly



Talk to the students: Introduce the step.



Analyzing Component Constraints Student book reference: Student Guide: Analyzing Component Constraints



Talk to the students:



Describe tabs. The Deactivated tab and Degrees of will appear ONLY if constraints are deactivated, broken, not updated, etc, or if a DOF analysis is possible. The Degree of Freedom Analysis dialog box may be opened from this tab by double-clicking component in the list.
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CATIA V5 Mechanical Design Expert Your Notes: Analyzing Dependencies Student book reference: Student Guide: Analyzing Dependencies



Talk to the students:



Reframe and zoom in the window with the usual mouse buttons.



Analyzing Degrees of Freedom Student book reference: Student Guide: Analyzing Degrees of Freedom



Talk to the students: The degrees of freedom of a component is analyzed to verify if the component is fully constrained in the assembly. 3. Describe the example shown.



Measuring Minimum Distances Student book reference: Student Guide: Measuring Minimum Distances, Edit Distance and Band Analysis Dialog Box



Talk to the students: To measure the minimum distance between components, products or groups of products. The main advantage of this tool is its ability to update the measure if a change has been made. Dynamic measurements can be made in DMU Fitting or Kinematics using this function. Describe the measurement options. The computation type will determine how many products have to be selected.



Measuring the Minimum Distance Student book reference: Student Guide: Measuring the Minimum Distance, Reading Minimum Distance Results



Talk to the students: Describe the steps and how to interpret the results.



Updating a Measure Student book reference: Student Guide: Updating a Measure
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CATIA V5 Mechanical Design Expert Your Notes: General Process to Create a Section Student book reference: Student Guide: Sections, General Process to Create a Section



Talk to the students:



Describe the steps. Do not go into details. 5. Save either in the tree and in a file.



How to Use the Section Tools (1/4) Student book reference: Student Guide: How to Use the Section Tools (1/2), Kinds of Sections



Talk to the students:



Describe the section modes, and volume cuts.



How to Use the Section Tools (2/4) Student book reference: Student Guide: How to Use the Section Tools (2/5), About Section Manipulation



Talk to the students:



Centered on the surrounding box center of the pre-selected elements. Dimensioned according to the longest dimension between the center of inertia and the furthest element. The default section plane does not normally have the correct position or size and will generally need to be repositioned, reoriented, and re-dimensioned. Describe the options without going into detail.



How to Use the Section Tools (3/4) Student book reference: Student Guide: How to Use the Section Tools (3/5), Viewing and Manipulating a Section Result



Talk to the students: Describe the options without going into detail.



COPYRIGHT DASSAULT SYSTEMES



95



CATIA V5 Mechanical Design Expert Your Notes: How to Use the Section Tools (4/4) Student book reference: Student Guide: How to Use the Section Tools (4/5), (5/5)



Talk to the students:



Manual Update is the default option. The section’s tree symbol will indicate that an update is required. This option improves the performance of CATIA because fewer updates are required at the instant a change is made. Freeze: Changes to any of the components will not affect the section. The section’s tree symbol will have a lock on it. This allows for a history of sectioning results to be created and kept. By default, the section viewer is locked in 2D view. Deactivating the 2D view allows users to work in a 3D view and set the same viewpoint in the section viewer as in the 3D model. Import Viewpoint applies the viewpoint of the 3D model onto the section result window. This option is only available if the 2D Lock is removed. Coordinates allows for specific coordinates to be labelled on the section Clean All Removes all the coordinate labels on the section.



Manipulating the Section Planes (1/3) Student book reference: Student Guide: Manipulating the Section Planes (1/6), (2/6)



Talk to the students: Review methods without going into detail. Size and graphic positioning will be described below. E. Graphic selection or 2/3 elements. Describe how to re-size and position.



Manipulating the Section Planes (2/3) Student book reference: Student Guide: Manipulating the Section Planes (3/6), (4/6), (6/6)



Talk to the students: The precise position of a section plane can be modified using the Edit Position icon from the Positioning tab. Set translation and rotation incremental values and then the buttons to increment. Use the Undo or Redo buttons as necessary. Select Close to exit and save the last plane position. Select the Geometrical Target icon from the Positioning tab. Normal to the selected edge or axis, tangent to a selected surface, normal to the axis of the selected cylindrical surface.
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CATIA V5 Mechanical Design Expert Your Notes: Manipulating the Section Planes (3/3) Student book reference: Student Guide: Manipulating the Section Planes (5/6), (6/6)



Talk to the students:



Select the Positioning by 2/3 Selections icon from the Positioning tab. To help make the selection the cursor shape changes to the item type (point, line, cylinder, cone, etc) over which it is placed.



What is Clash, Contact, and Clearance? Student book reference: Student Guide: What is Clash, Contact, and Clearance?



Talk to the students: Red intersection curves identify clashing components. Yellow triangles identify components in contact. Green triangles identify components separated by less than the specified clearance distance.



Accessing the Clash Tools Student book reference: Student Guide: Accessing the Clash Tools



Talk to the students:



Review differences between the two tools.



Using the Compute Clash Tool Student book reference: Student Guide: Using the Compute Clash Tool



Talk to the students: Limited to clash or clearance analysis.
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CATIA V5 Mechanical Design Expert Your Notes: Using the Clash Tool (1/2) Student book reference: Student Guide: page title



Talk to the students:



The Clash tool is a more in depth analysis of clash, contact, and clearance. Review the analysis types. 3. Enter a value for the clearance if a clearance analysis was selected. Authorized penetration: Detect components that intersect by more than the defined value. Review the computation types. 5. The possible selections will depend on the computation type.



Using the Clash Tool (2/2) Student book reference: Student Guide: Using the Clash Tool (3/4), (4/4)



Talk to the students: List by Conflict tab lists each conflict that exists. List by Product tab lists all the conflicts that exist for each component within the selection. 3. The Value field for that conflict will be filled in with the clash or clearance value. The Status field updates to Relevant. This value can be changed to Irrelevant by selecting the word Relevant for that conflict. Also, a preview window of the two components conflict will appear, as well as the area in conflict. In the example, a red curve outlines the location of the clash.



Exercise Overview Student book reference: Student Guide: Assembly Analysis (Detailed Instructions), Clash Analysis and Section (Detailed Instructions)



Show the students:



Demonstrate the topics learned in this part of the lesson before or after students work on the exercises.



Talk to the students: Tell students where they will be saving the models to and where the required start parts are located.
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CATIA V5 Mechanical Design Expert Your Notes: Assembly Analysis (Detailed Instructions): Recap Student book reference: Student Guide: Assembly Analysis (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Clash Analysis and Section (Detailed Instructions): Recap Student book reference: Student Guide: Clash Analysis and Section (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Create Scenes Student book reference: Student Guide: Create Scenes



Talk to the students: Introduce the step.



What Are Scenes? Student book reference: Student Guide: What Are Scenes?



Talk to the students: Scenes are stored in an assembly’s product file.



Why Use Scenes? Student book reference: Student Guide: Why Use Scenes?



Talk to the students:



D. Typically, generation of exploded views.
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CATIA V5 Mechanical Design Expert Your Notes: Enhanced Scenes Workbench Student book reference: Student Guide: Enhanced Scenes Workbench



Talk to the students:



Review available tools.



Creating a Scene Student book reference: Student Guide: Creating a Scene (1/3), (2/3)



Talk to the students: Scenes capture the viewpoint of the model at the instant the Enhanced Scene icon is selected, as well as the state (color, position, activation, etc) of the main assembly. The main assembly drives the state of all the components unless it was modified in the scene. Uncheck the Automatic naming option in order to enter the required name. In full overload mode, a change in the position of assembly components WILL NOT be reflected in the scene. The assembly and the scene have independent behaviours. In partial overload mode, a change in the position of assembly components WILL be reflected in the scene. The icon in the specification tree indicated which mode is used.



Creating a New Scene from an Existing Scene Student book reference: Student Guide: Creating a Scene (3/3), Creating a New Scene from an Existing Scene



Talk to the students: The first scene of an assembly can only be created with the Enhanced Scene icon. Additional scenes can also be created by copying existing scenes. Another way to copy a scene is to select a scene in the tree and press the Enhanced Scene icon.



Creating a Scene of a Subset of the Assembly Student book reference: Student Guide: Creating a Scene of a Subset of the Assembly



Talk to the students: The scene will capture the current color, position, and hide state of the assembly components when the scene is created.
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CATIA V5 Mechanical Design Expert Your Notes: General Scene Management Student book reference: Student Guide: General Scene Management



Talk to the students:



E. Applies the component attributes, such as position, colour, and hide/show state, to a scene.



Applying a Scene on the Assembly Student book reference: Student Guide: Applying a Scene on the Assembly



Talk to the students:



Alternatively, select the Apply Scene on Assembly icon from the Enhanced Scene toolbar to apply selected attributes. 3. Describe use of dialog box.



Applying the Assembly on a Scene Student book reference: Student Guide: Applying the Assembly on a Scene



Talk to the students: Type speech



Applying User Defined Attributes Student book reference: Student Guide: Applying User Defined Attributes



Talk to the students:



3. Use contextual menu Apply xxx on attribute The status will change from X to Lock.



Hiding Components in a Scene Student book reference: Student Guide: Component Management in Scenes, Hiding Components in a Scene



Talk to the students: Attributes are modified without modifying the Show/hide state, Graphic properties, position and Activation/deactivation state in the main assembly.
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CATIA V5 Mechanical Design Expert Your Notes: Modifying and Moving Components Student book reference: Student Guide: Modifying Graphic Properties of Components in a Scene, Moving Components in a Scene



Talk to the students: The same methods apply as for moving a component in an assembly. The Snap tool can also be used to move components.



Exploding an Assembly in a Scene (1/2) Student book reference: Student Guide: Exploding an Assembly in a Scene (1/2)



Talk to the students:



To explode an assembly without modifying the main assembly. Describe the options.



Exploding an Assembly in a Scene (2/2) Student book reference: Student Guide: Exploding an Assembly in a Scene (2/2)



Talk to the students: Type speech



Creating a Drafting View Based on a Scene Student book reference: Student Guide: Drafting Views Based on Scenes, Creating a Drafting View Based on a Scene



Talk to the students: Drafting views created from scenes allow for specific component attributes stored in a scene to be conveyed in a drawing.



Create Annotations Student book reference: Student Guide: Create Annotations



Talk to the students: Introduce the step.
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CATIA V5 Mechanical Design Expert Your Notes: Introduction to Annotations Student book reference: Student Guide: Introduction to Annotations, Weld Feature Annotations



Talk to the students: Annotations are added to assembly documents to provide additional information about a part or product. This additional information can include a brief description of the part, the material used for the part, the use of the part, the finish requirements, or the hardness requirements. Review the use of the 3 annotation types.



Creating a Weld Feature Annotation Student book reference: Student Guide: Creating a Weld Feature Annotation (1/2), (2/2)



Talk to the students:



Describe steps and review weld options.



Creating Text Annotations Student book reference: Student Guide: What are Text Annotations?, Creating Text Annotations



Talk to the students:



A text annotation is text visible in the 3D view. Text annotations are associated with a geometric element of a an assembly component. When a text annotation is created, an FD&T view will be automatically created if one with the required orientation does not currently exist. Edit the text annotation by double-clicking on it in the tree.



Creating Flag Notes Student book reference: Student Guide: What are Flag Notes?, Creating Flag Notes



Talk to the students: A flag note contains a hyperlink that can launch a document such as a presentation, a Microsoft Excel spreadsheet or an HTML page. When a text annotation is created, an FD&T view will be automatically created if one with the required orientation does not currently exist. Edit the text annotation by double-clicking on it in the tree.
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CATIA V5 Mechanical Design Expert Your Notes: Changing the Annotation Supporting View Student book reference: Student Guide: Manipulating Annotations, Changing the Annotation Supporting View



Talk to the students: The annotations discussed require a supporting view. If a 3D view does not exist prior to the creation of the annotation, then one is automatically created. The 3D view on which the annotation is created can be changed. The appearance of annotations can be modified. Example:the shape and size of the leader symbols.



Modifying Annotation Leaders Student book reference: Student Guide: Manipulating Annotation Leaders (1/3), (2/3)



Talk to the students:



When adding a leader, a geometric support must be selected. If a weld feature’s leader is removed, the weld process will not be visible.



Projecting Annotation Views on a Drawing Student book reference: Student Guide: Projecting Annotation Views on a Drawing



Talk to the students: Ensure that the 3D and 2D views use the same standards, ISO or ANSI. If not, the 3D view cannot be added to the drawing.



Generate Reports Student book reference: Student Guide: Generate Reports



Talk to the students: Introduce the step.



Generating Reports Student book reference: Student Guide: Generating Reports



Talk to the students:



Assembly listing report: Use this to list the components belonging to a CATProduct.
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CATIA V5 Mechanical Design Expert Your Notes: Generating Bill of Materials Reports Student book reference: Student Guide: What are Bill of Materials Reports?, Generating Bill of Materials Reports



Talk to the students: A Bill of materials report list all the components of an assembly as well as information such as the quantity, type, and description. Additional information can be included. Select or activate the assembly or sub-assembly for which to generate a bill of materials before selecting the menu. Text file, html or Excel format.



Customizing Bill of Materials Reports Student book reference: Student Guide: Customizing Bill of Materials Reports, Removing a Component from the Bill of Materials



Talk to the students: The contents of the recapitulation can also be customized in the same way.



Assembly Listing Reports Student book reference: Student Guide: What are Assembly Listing Reports?, Generating Assembly Listing Reports, Saving Assembly Listing Reports, Customizing Assembly Listing Reports



Talk to the students:



An assembly listing reports lists all the component of assemblies in a hierarchical format. Can be customized in the same way as a bill of materials report. Saved file in text file format only.
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CATIA V5 Mechanical Design Expert Your Notes: Exercise Overview Student book reference: Student Guide: Scenes (Detailed Instructions), Symbols and Annotations (Detailed Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises.



Talk to the students:



As a class discuss what will be involved in completing the exercises. What tools will they need to use? Tell students where they will be saving the models to and where the required start parts are located. State that they are to complete the exercise before moving on to the case study (time permitting).



Case Study: Assembly Design Student book reference: Student Guide: Case Study: Assembly Design



Talk to the students:



Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Have the students begin the exercises and note the time. Assist students as needed with the exercises.



Scenes (Detailed Instructions): Recap Student book reference: Student Guide: Scenes (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Mechanical Design Expert Your Notes: Symbols and Annotations (Detailed Instructions): Recap Student book reference: Student Guide: Symbols and Annotations (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Case Study: Assembly Design Recap Student book reference: Student Guide: Case Study: Assembly Design Recap
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CATIA V5 Mechanical Expert Your Notes:



Lesson 7: Contextual Design Contextual Design Student book reference: Student Guide: Design in Context



Talk to the students: Introduce the lesson.



Case Study Student book reference: Student Guide: Case Study, Design Intent, Stages in the Process



Talk to the students:



Contextual links must be used in order to ensure that changes to referenced parts are reflected in the contextual part. Use the Analyze dependencies tool you can ensure that only the Housing component is reference. By creating the cut at the assembly level you can control which components the cut will intersect. Using the Send To directory option you can be sure that all files associated with the assembly are copied to the required directory.



Clarify the Display Student book reference: Student Guide: Clarify the Display



Talk to the students: Introduce the step.



Working with Large Assemblies Student book reference: Student Guide: Working with Large Assemblies, Visualization Mode



Talk to the students: Decreases in the performance of CATIA can occur. It can take longer to open, zoom, pan, update and save large assemblies. It can also take more time to generate and update drafting views. Review specification tree display.
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CATIA V5 Mechanical Expert Your Notes: Comparison Between Visualization and Design Mode Student book reference: Student Guide: Comparison Between Visualization and Design Mode (1/2), (2/2)



Talk to the students: Review main, and most apparent, differences.



User Setting: Turning on the Cache Student book reference: Student Guide: User Setting: Turning on the Cache (1/2), (2/2)



Talk to the students:



Explain the use of the cache system. Note that this may be an enterprise-wide imposed method of working. Notice the difference in the display of the retrieved assembly when CATIA restarted. Now we will see how we switch back to design mode for modifications.



Switching to Design Mode Student book reference: Student Guide: Manually Switching to Design Mode



Talk to the students: Describe manual steps. If a sub-assembly is selected then all components of that assembly will switch to design mode. The Automatic Switch to Design mode option allows you to add constraints between components that have been loaded in visualization mode.



Update Status Unknown Student book reference: Student Guide: Update Status Unknown



Talk to the students: Access the option from Tools > Options, Mechanical Design node, Assembly Design node, General tab. The assembly is up to date, but without switching to Design mode and loading full geometrical description.
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CATIA V5 Mechanical Expert Your Notes: Comparison Between Show and Hide Student book reference: Student Guide: Hiding Components, Comparison Between Show and Hide (1/2), (2/2)



Talk to the students: Compare the display of the shown/hidden components in the specification tree. Components excluded from drawing views, but features accessible for part design. The hide/show state of a component is stored in the CATProduct file.



Showing and Hiding a Component Student book reference: Student Guide: Hiding Components, Showing Components



Talk to the students:



Use the key while selecting multiple components.



Deactivating Representations Student book reference: Student Guide: Deactivating Representations, Why Deactivate Representations? (1/2), (2/2)



Talk to the students: Improved performance when opening assemblies. Not dimmed in specification tree. The activation/deactivation state can be stored in the CATProduct. If the option Do not activate default shapes on open is checked then only the specification tree will be visible when a product is opened.



Differences Between Activating and Deactivating Representations Student book reference: Student Guide: Differences Between Activating and Deactivating Representations (1/2), (2/2)



Talk to the students: Principal differences only.
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CATIA V5 Mechanical Expert Your Notes: Activating and Deactivating a Representation Student book reference: Student Guide: Deactivating Representations, Activating Representations



Talk to the students: Use Deactivate Terminal Node to deactivate all the parts within a selected assembly. You can deactivate more than one component at a time by using the key while selecting.



Saving the Activation State Student book reference: Student Guide: Saving the Activation State (1/2), (2/2)



Talk to the students:



Saves the current activation state in the product for all the product components. The product must then be saved in the usual way.



Deactivating Components Student book reference: Student Guide: Deactivating Components



Talk to the students:



Be careful – another instance of the component is NOT the same component. In the example, both component instances have been deactivated.



Differences Between Modes (1/2) Student book reference: Student Guide: Differences Between Modes (1/2)



Talk to the students:



Point out and review principal advantages of the various modes.



Differences Between Modes (2/2) Student book reference: Student Guide: Differences Between Modes (2/2)



Talk to the students:



Point out and review principal advantages of the various modes.
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CATIA V5 Mechanical Expert Your Notes: Deactivating a Component Student book reference: Student Guide: Deactivating a Component (1/2), (2/2)



Talk to the students:



If a product document which uses the component is also open, the component will also be deactivated in this product.



Effects on the Bill of Materials Student book reference: Student Guide: Effects on the Bill of Materials



Talk to the students:



Compare effects on BOM.



Selective Load (1/2) Student book reference: Student Guide: Selective Load, Using the Selective Load Tool (1/2)



Talk to the students: When working with large assemblies all documents do not need to be loaded. Use the Selective Load tool to load only some of the components in an assembly.



Selective Load (2/2) Student book reference: Student Guide: Using the Selective Load Tool (2/2)



Talk to the students: Explain the depth options (1, 2, or all).



To Sum Up (1/2) Student book reference: Student Guide: page title



To Sum Up (2/2) Student book reference: Student Guide: To Sum Up (2/2)
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CATIA V5 Mechanical Expert Your Notes: Exercise Overview Student book reference: Student Guide: Component Visualization (Detailed Instructions), Visualization Mode (Detailed Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class.



Talk to the students:



Present the exercises available to practice the skills learned in this part of the lesson.



Component Visualization (Detailed Instructions): Recap Student book reference: Student Guide: Component Visualization (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Visualization Mode (Detailed Instructions): Recap Student book reference: Student Guide: Visualization Mode (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Create Contextual Parts Student book reference: Student Guide: Create Contextual Parts



Talk to the students:



Introduce the step.
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CATIA V5 Mechanical Expert Your Notes: What are Contextual Parts? (1/2) Student book reference: Student Guide: What are Contextual Parts?, Contextual Parts Using External Parameters



Talk to the students: The reference part is sometimes referred to as the skeleton. Describe the scenario using external parameters in general terms.



What are Contextual Parts? (2/2) Student book reference: Student Guide: Contextual Parts Using External References, Contextual Parts Using Assembly Features



Talk to the students: Describe the scenarios in general terms.



Why Design in Context? Student book reference: Student Guide: Why Design in Context?, Contextual Part Specification Tree Symbols



Talk to the students: Describe the reasons.



Creating Contextual Elements Student book reference: Student Guide: Creating Contextual Elements



Talk to the students:



Contextual elements can be created when designing sketches and features in context. External geometry is copied from driving parts to contextual parts that are being driven. The copies are organized in the External References branch of the part.
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CATIA V5 Mechanical Expert Your Notes: Constraining Contextual and Non--Contextual Instances Student book reference: Student Guide: Constraining Contextual Instances of Parts (1/2), (2/2), Constraining Non-Contextual Instances of Parts



Talk to the students: Assembly constraints are forbidden when there is a potential conflict between geometric and assembly constraints. Assembly constraints are always forbidden when an element in a sketch is associative. Both cases have external links. Case 1: The pad’s sketch has external links to the base plate. Case 2: The shaft has an external link to the housing part. Assembly constraints can be used with non-contextual parts when there is NO conflict between assembly and geometry constraints. These parts have no conflicting geometric constraints.



Sketch in Context Student book reference: Student Guide: Sketch in Context, Why Use a Sketch in Context?



Talk to the students: If the sketch in the original instance is modified, the geometry of the contextual part is also modified. Easier to synchronize references.



Using a Sketch as an External Reference Student book reference: Student Guide: Using a Sketch as an External Reference (1/2), (2/2)



Talk to the students: Describe the steps. Note the impacts after update. Relative positions of the pad and the reference planes of the part have changed.



Creating a Parameter in Context (1/3) Student book reference: Student Guide: Parameters in Context, Creating a Parameter in Context (1/3)



Talk to the students: Two cases, the first of which will be described. The other case, where assembly parameters can be used to drive component parameters, will be described later. Describe the steps. Step 3. Select the parameter which will be driven by the formula.
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CATIA V5 Mechanical Expert Your Notes: Creating a Parameter in Context (2/3) Student book reference: Student Guide: Parameters in Context, Creating a Parameter in Context (2/3)



Talk to the students: Describe the steps. The contents of the External parameters selection box will depend upon the current selection.



Creating a Parameter in Context (3/3) Student book reference: Student Guide: Parameters in Context, Creating a Parameter in Context (3/3)



Talk to the students:



Describe the specification tree modifications. The component still has a yellow gear for its specification tree symbol indicating that it is not contextual to the assembly.



Using an Assembly Parameter to Design a Part (1/3) Student book reference: Student Guide: Using an Assembly Parameter to Design a Part (1/3)



Talk to the students: We have seen the first case, where parameters of one part can be used to drive the parameters of another part. Now we will see how a parameter of a part can be driven by an assembly parameter. Describe the steps. Step 3. Select the parameter which will be driven by the formula.



Using an Assembly Parameter to Design a Part (2/3) Student book reference: Student Guide: Using an Assembly Parameter to Design a Part (2/3)



Talk to the students: The contents of the External parameters selection box will depend upon the current selection.
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CATIA V5 Mechanical Expert Your Notes: Using an Assembly Parameter to Design a Part (3/3) Student book reference: Student Guide: Using an Assembly Parameter to Design a Part (3/3)



Talk to the students: Describe the specification tree modifications. The component still has a yellow gear for its specification tree symbol indicating that it is not contextual to the assembly.



External Parameters Student book reference: Student Guide: External Parameters, Why Use External Parameters?



Talk to the students:



Verify that the Keep link with selected object option is set. Review the 2 creation methods. Review advantages. Explain example shown.



Fully Constraining Contextual Parts Student book reference: Student Guide: Fully Constraining Contextual Parts, Fixing Contextual Parts in Space



Talk to the students: Fully constrain: The housing part is contextually designed and has external references to the geometrical elements of the base part. Fix: The slot in the brown part is fully constrained.



Editing Contextual and Driving Parts Student book reference: Student Guide: Editing Contextually-Related Parts, Editing Driving Parts, Editing Contextual Parts



Talk to the students:



Identify which parts are contextual and which are driving.
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CATIA V5 Mechanical Expert Your Notes: Editing a Driving Part Student book reference: Student Guide: Editing a Driving Part



Talk to the students:



If a driving part is modified outside the context of the assembly, the assembly must be opened to fully update the contextual parts. Contextual elements can be updated only in the context in which they were defined. The update will depend upon the whether synchronization is set to manual, or automatic (as in this case).



Automatic Synchronization Student book reference: Student Guide: Automatically Synchronizing Changes when Editing Driving Parts



Talk to the students:



This is the simplest option.



Manual Synchronization Student book reference: Student Guide: Manually Synchronizing Changes when Editing Driving Parts (1/2), (2/2)



Talk to the students: Contextual elements can be synchronized individually in order to control the order in which elements are updated. Describe the steps.



Replacement Of a Driving Component (1/2) Student book reference: Student Guide: Replacement Of a Driving Component (1/3), (2/3)



Talk to the students: When you replace a component that is used as a reference for other contextual components, the driven components need to be reconnected to the new driving geometry. Describe the steps.
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CATIA V5 Mechanical Expert Your Notes: Replacement Of a Driving Component (2/2) Student book reference: Student Guide: Replacement Of a Driving Component (2/3), (3/3)



Talk to the students:



Describe the steps. Step 7. The external references are no longer synchronized because the reference element has been removed from the assembly. Step 8. The profile and the limiting element both need to be redefined. Select new references for both missing elements.



Exercise Overview Student book reference: Student Guide: Feature in Context (Detailed Instructions), Sketch in Context (Detailed Instructions), Part in Context



Show the students:



Demonstrate the topics learned in this part of the lesson before or after students work on the exercises.



Talk to the students: Tell students where they will be saving the models to and where the required start parts are located.



Feature in Context (Detailed Instructions): Recap Student book reference: Student Guide: Feature in Context (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Sketch in Context (Detailed Instructions): Recap Student book reference: Student Guide: Sketch in Context (Detailed Instructions): Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Mechanical Expert Your Notes: Part in Context: Recap Student book reference: Student Guide: Part in Context: Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Create Assembly-Level Features Student book reference: Student Guide: Create Assembly-Level Features



Talk to the students: Introduce the step.



Assembly-Level Features Student book reference: Student Guide: Assembly-Level Features (1/2), (2/2)



What are Assembly Features? Student book reference: Student Guide: What are Assembly Features? (1/3), (2/3)



Talk to the students: Review the main tools. They will be described in detail later. The Add and Remove tools use another part body in the same way as the Split tool.



What are Affected Parts? Student book reference: Student Guide: What are Affected Parts?
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CATIA V5 Mechanical Expert Your Notes: Specifying Affected Parts Student book reference: Student Guide: Specifying Affected Parts



Talk to the students:



Select multiple items using the or keys.



Creating an Assembly Split Student book reference: Student Guide: Creating an Assembly Split



Talk to the students: A surface or a plane to make the split is required.



Creating an Assembly Hole (1/2) Student book reference: Student Guide: Creating an Assembly Hole



Talk to the students: The hole positioning sketch will be created in the part which contains the reference plane. Describe steps. The Add Series button allows you to define different hole specifications for each affected part.



Creating an Assembly Hole (2/2) Student book reference: Student Guide: Using Hole Series



Talk to the students: Step 3. The Hole Definition dialog box will reappear.



Creating an Assembly Pocket Student book reference: Student Guide: Creating an Assembly Pocket



Talk to the students: The sketch need not belong to one of the affected parts.
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CATIA V5 Mechanical Expert Your Notes: Adding and Removing Bodies Student book reference: Student Guide: Adding a Body to an Assembly, Removing a Body from an Assembly



Talk to the students: In order to see an added body you will need to hide the other components.



Cautions About Designing in Context Student book reference: Student Guide: Cautions About Designing in Context



Manipulate the Contextual Components Student book reference: Student Guide: Manipulate the Contextual Components



Talk to the students: Introduce the step.



Isolating All Elements Student book reference: Student Guide: Isolating Contextual Parts, Isolating All Elements in a Contextual Part



Talk to the students: Inadvertent changes need to be avoided. No longer a need to drive changes between the parts. Describe steps.



Isolating Individual Elements Student book reference: Student Guide: Isolating Individual Elements in a Contextual Part



Talk to the students:



Describe steps.
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CATIA V5 Mechanical Expert Your Notes: Analyzing Relationships (1/2) Student book reference: Student Guide: Analyzing Relationships Between Driving and Driven Components



Analyzing Relationships (2/2) Student book reference: Student Guide: Analyzing Relationships Between Driving and Driven Components



Talk to the students: To help see the relationship between driving and driven elements, temporarily show (unhide) the external reference elements and then select the elements to highlight them



Deleting Driving Components Student book reference: Student Guide: Deleting Contextually-Related Components (2/2), Deleting Driving Components



Talk to the students:



When a component that drives a contextual part is deleted, the option to delete the contextual components that are driven by the component is available. When a driving component is deleted a warning message can appear stating that a new context should be established before synchronizing external references.



Deleting Contextual Components Student book reference: Student Guide: Deleting Contextually-Related Components (1/2), Deleting Contextual Components



Talk to the students: This scenario applies when the original instance of a contextual part is deleted. A warning message appears stating that a new original instance should be established.



Save the Contextual Models Student book reference: Student Guide: Save the Contextual Models



Talk to the students:



Introduce the step.
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CATIA V5 Mechanical Expert Your Notes: Saving Contextual Parts Student book reference: Student Guide: Saving Contextually-Related Components, Saving Driving CATParts, Saving Contextual CATParts, Saving Parent CATProducts



Talk to the students: In the example shown, the Small Block references elements in the Bottom Block instance of the Large Block part. The referenced documents can include other CATParts and the parent CATProduct. The Save Management tool, discussed in the Fundamental course, can help manage the impacts.



Copying a Product to a new Directory Student book reference: Student Guide: Copying CATProducts Using Send to Directory



Talk to the students: To copy a product and all its contextual parts to a separate directory all components must have been previously stored.



Exercise Overview Student book reference: Student Guide: Assembly Split and Hole (Detailed Instructions), Links Analysis (Detailed Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises.



Talk to the students:



As a class discuss what will be involved in completing the exercises. What tools will they need to use? Tell students where they will be saving the models to and where the required start parts are located. State that they are to complete the exercise before moving on to the case study (time permitting).
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CATIA V5 Mechanical Expert Your Notes: Case Study: Contextual Design Student book reference: Student Guide: Case Study: Design Complex Parts



Talk to the students:



Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Have the students begin the exercises and note the time. Assist students as needed with the exercises.



Assembly Split and Hole (Detailed Instructions): Recap Student book reference: Student Guide: Assembly Split and Hole (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Links Analysis (Detailed Instructions): Recap Student book reference: Student Guide: Links Analysis (Detailed Instructions): Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Case Study: Contextual Design Recap Student book reference: Student Guide: Case Study: Contextual Design Recap



Talk to the students: Discuss the objectives of the case study. Ensure the students understand the process used to create the case study before beginning the next lesson.
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CATIA V5 Mechanical Design Expert Your Notes:



Lesson 8: Complex Assembly Design Complex Assembly Design Student book reference: Student Guide: Complex Assembly Design



Talk to the students: Introduce the lesson.



Case Study Student book reference: Student Guide: Case Study: Complex Assembly Design



Talk to the students:



Introduce the case study. Review steps



Create the Skeleton Model Student book reference: Student Guide: Create the Skeleton Model



Talk to the students:



Introduce the step.



What is the Skeleton Method? (1/2) Student book reference: What is the Skeleton Method? (1/2)



Talk to the students: The skeleton method is a top down design approach. Using the skeleton method you create and reuse the information stored in a single part, called the skeleton, to define the underlying design framework of individual components and assemblies. The Skeleton method is part of the Specification Driven Method. A skeleton model is stored in a CATPart file.
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CATIA V5 Mechanical Design Expert Your Notes: What is the Skeleton Method? (2/2) Student book reference: What is the Skeleton Method? (2/2)



Talk to the students:



Geometrical elements such as curves, axis, points, planes, and surfaces are stored in the skeleton. Design the other components of the product by creating external references pointing to the skeleton. Position constraints between the skeleton and other components of the product.



Why use Skeleton Method? Student book reference: Why use Skeleton Method?



Talk to the students: Specification-driven design: All important information is stored in the skeleton model. Space constraints are clearly defined within the skeleton to help allocate space for the components within the assembly. Design changes: The skeleton method helps manage high-level design changes and propagate them throughout the assembly. Modifications to design information in the skeleton model propagates to all the relative individual components and sub-assemblies. This provides you more control over changes in design. Collaborative design: Key information stored in the skeleton model can be associatively copied into the appropriate components used the product. The components can then be edited separately by different designers. Changes to the design can be made in the skeleton and all models will update to reflect these modifications. Because the components are not linked to each other, the deletion of a component within an assembly will not impact the others.
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CATIA V5 Mechanical Design Expert Your Notes: How is the Skeleton Method Implemented? Student book reference: How is the Skeleton Method Implemented?



Talk to the students:



This is called a “Top-Down” method because all the information is stored in the Skeleton Part and is propagating down to all the other components. There is a contextual link between the Skeleton and Component1 There is a contextual link between the Skeleton and Component2 There is a contextual link between the Skeleton and Component3 The positioning constraints are in the same direction as the contextual links. When using the skeleton method, contextual and positioning links only point to the skeleton part. This ensures the links will not interfere. Moreover, you can delete one contextual part, “Component2” for example, without any impact on the others. Notice the direction of information is always downward (i.e., top down), from the skeleton model to the other components.



What Does a Skeleton Model Contain? Student book reference: What Does a Skeleton Model Contain?



Talk to the students: It is strongly recommended to choose parameters as specifications for your skeletons. Parameters can be reused in many more cases than geometry.



Constraints and the Skeleton Model Student book reference: Constraints and the Skeleton Model



Talk to the students:



To properly use the skeleton method, models are constrained using only the skeleton model as reference for positioning. Geometrical elements within the skeleton model (such as points, curves, planes, and axis) are used as constraint references for the assembly components.
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CATIA V5 Mechanical Design Expert Your Notes: Reusing Skeleton in Sub-Assemblies Student book reference: Reusing Skeleton in Sub-Assemblies



Talk to the students:



It is possible to use the skeleton method in a product which contains sub-assemblies. In this case, you create a sub-skeleton for each of the subassemblies that require additional information to drive it. All necessary information from the main skeleton is copied into the sub-skeletons using the Paste Special option As Result with link. Additional information only relevant to the particular sub-assembly is then added.



Exercise Overview Student book reference: , Exercise: Skeleton and Design in Context (Limited Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises. Decide when to do the demonstration based on the class.



Talk to the students:



Present the exercises available to practice the skills learned in this part of the lesson.



Skeleton Model Use (Detailed Instructions): Recap Student book reference: Student Guide: Exercise: Skeleton Model Use Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?
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CATIA V5 Mechanical Design Expert Your Notes: Skeleton Parameter Use (Detailed Instructions): Recap Student book reference: Student Guide: Exercise: Skeleton Parameter Use Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Ask the students: Ask if there are any questions about this exercise, any difficulties?



Skeleton and Design in Context (Limited Instructions): Recap Student book reference: Student Guide: Exercise: Skeleton and Design in Context Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different options used in this exercise.



Create the Published Elements Student book reference: Student Guide: Create the Published Elements



Talk to the students: Introduce the step.
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CATIA V5 Mechanical Design Expert Your Notes: Why Publish Geometry? Student book reference: Why Publish Geometry?



Talk to the students:



A. give it a name that can be easily recognized (particularly in the case of publishing edges, faces, etc.). B. To make particular geometry easier to access from the specification tree C. An option is available that lets you only select as external reference only the published elements. D. Published elements that have same name in the source part and the child part are automatically reconnected, as you would have to reconnect them all one by one if they are not published.



Show the students: Show the label of the inputs Show the access to geometry (show that you can give access only to selected data and not to others) Show restricted access only to published elements in MML environment (show option)



What Kind of Geometry Can be Published? Student book reference: What Kind of Geometry Can be Published?



Talk to the students: Some exemples of elements that can be published in the geometry



Published Elements in the Tree Student book reference: Published Elements in the Tree



Talk to the students: Understand how the publications appear in the tree: The tree displays names of published elements under the components Publication node. The green gear on a component icon indicates that the component has been designed using external references. C. External references = copy with link of published elements from another part of the assembly Elements that are updated are denoted by the letter P in a cyan color. Published elements that are not synchronized are denoted by a P in a yellow circle.



Show the students:



In CATIA V5, open an assembly with published elements and external references and show the previous elements
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CATIA V5 Mechanical Design Expert Your Notes: Publishing Parameters Student book reference: Publishing Parameters



Talk to the students:



Publication of parameters is useful when replacing a component in an assembly that contains parameters used to drive other components (i.e., exported parameters). If the exported parameters are published and the parameters of the replacing component are published under the same names, they will inherit the control of the exported parameters. Otherwise the parameters of the replaced component will keep the control. For example, the number of holes and pattern diameter of the rim are reused in the hub. A. If the parameters are not published, the hub will continue to sue the parameters for the original rim and not update. B. If the parameters are published and the rim is replaced with a bigger one, the parameters update to the new values.



Use the Published Elements Student book reference: Student Guide: Use the Published Elements



Talk to the students: Introduce the step.



When Can You Use Published Geometry? Student book reference: When Can You Use Published Geometry ?



Talk to the students: Using geometry publication is useful when you want to use an element from another part to constrain the geometry. For instance in the A example, to be able to create a coaxial constraint between the 2 axis, if one of the axis is in another part, you need to publish this axis. The advantage is then that user will not be able to create constraint with something else and so you are sure the constraint will be created with the good elements. In the B example, you need an external surface to re-limit the solid you are currently creating. In this case you don‘t need external references to constraint geometry but to complete geometry. The advantage is that if the surface is replaced in the origin part (containing the original surface), then the design of the solid will follow if the publication keep the same name with publication, the id of the imported element is not taken in account but its publication name (which is easily manageable).



Show the students: Demonstrate the use of published elements and their replacement
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CATIA V5 Mechanical Design Expert Your Notes: Published Geometry and Contextual Design Student book reference: Published Geometry and Contextual Design



Talk to the students:



When you replace a component with published elements, the links to contextual components are automatically reconnected. With published elements there is not a need to re-connect the removed external references, they are automatically replaced with the corresponding published element from the replacing component.



Exercise Overview Student book reference: Student Guide: Publication (Detailed Instructions) , Parameter Publication (Detailed Instructions), Publication (Limited Instructions)



Show the students: Demonstrate the topics learned in this part of the lesson before or after students work on the exercises.



Talk to the students: As a class discuss what will be involved in completing the exercises. What tools will they need to use? Tell students where they will be saving the models to and where the required start parts are located. State that they are to complete the exercise before moving on to the case study (time permitting).



Case Study: Complex Assembly Design Student book reference: Student Guide: Case Study: Complex Assembly Design



Talk to the students: Review the requirements for the case study. Discuss as a class how the model will be created, what tools are needed to create the case study? Have the students begin the exercises and note the time. Assist students as needed with the exercises.
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CATIA V5 Mechanical Design Expert Your Notes: Publication (Detailed Instructions): Recap Student book reference: Student Guide: Publication : Recap



Talk to the students:



Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Parameter Publication (Detailed Instructions): Recap Student book reference: Student Guide: Parameter Publication : Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Publication (Limited Instructions): Recap Student book reference: Student Guide: Publication : Recap



Talk to the students: Review the Exercise Recap slides after the students have attempted the exercises. Discuss the different tools used in this exercise. $Ask: Ask if there are any questions about this exercise, any difficulties?



Case Study: Complex Assembly Design Recap Student book reference: Student Guide: Case Study: Complex Assembly Design Recap



Talk to the students: Discuss the objectives of the case study. Ensure the students understand the process used to create the case study before beginning the next lesson.
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